NIST SPECIAL PUBLICATION 1800-19C

Trusted Cloud:

Security Practice Guide for VMware Hybrid Cloud
Infrastructure as a Service (laaS) Environments

Volume C:
How-to Guides

Michael Bartock Harmeet Singh Karen Scarfone

Murugiah Souppaya Rajeev Ghandi Scarfone Cybersecurity

Computer Security Division Laura E. Storey Clifton, Virginia

Information Technology IBM

Laboratory Armonk, New York Anthony Dukes
Jeff Haskins

Daniel Carroll Raghuram Yeluri Carlos Phoenix

Robert Masten Intel Brenda Swarts

Dell/EMC Santa Clara, California VMware

Hopkinton, Massachusetts Palo Alto, California

Michael Dalton

Gina Scinta Rocky Weber

Paul Massis RSA

Gemalto Bedford, Massachusetts

Austin, Texas

October 2021

DRAFT

This publication is available free of charge from:
https://www.nccoe.nist.gov/projects/building-blocks/trusted-cloud

ler N CCoe&e

National Institute of ® ol e =gl
Standards and Technology CER ?E R EYCE L(l:_ Al
U.S. Department of Commerce



https://www.nccoe.nist.gov/projects/building-blocks/trusted-cloud

N oo bk wN

(o]

10
11
12

13
14

15

16
17

18

19

20

21
22
23
24
25
26

DRAFT

Certain commercial entities, equipment, products, or materials may be identified by name or company
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an
experimental procedure or concept adequately. Such identification is not intended to imply special sta-
tus or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it in-
tended to imply that the entities, equipment, products, or materials are necessarily the best available
for the purpose.

While NIST and the NCCoE address goals of improving management of cybersecurity and privacy risk
through outreach and application of standards and best practices, it is the stakeholder’s responsibility
to fully perform a risk assessment to include the current threat, vulnerabilities, likelihood of a
compromise, and the impact should the threat be realized before adopting cybersecurity measures such
as this recommendation.

National Institute of Standards and Technology Special Publication 1800-19C, Natl. Inst. Stand. Technol.
Spec. Publ. 1800-19C, 124 pages, (October 2021), CODEN: NSPUE2

You can improve this guide by contributing feedback. As you review and adopt this solution for your
own organization, we ask you and your colleagues to share your experience and advice with us.

Comments on this publication may be submitted to: trusted-cloud-nccoe @nist.gov.

Public comment period: October 27, 2021 through December 6, 2021

All comments are subject to release under the Freedom of Information Act.

National Cybersecurity Center of Excellence
National Institute of Standards and Technology
100 Bureau Drive
Mailstop 2002
Gaithersburg, MD 20899

Email: nccoe@nist.gov
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The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and
academic institutions work together to address businesses’ most pressing cybersecurity issues. This
public-private partnership enables the creation of practical cybersecurity solutions for specific
industries, as well as for broad, cross-sector technology challenges. Through consortia under
Cooperative Research and Development Agreements (CRADAs), including technology partners—from
Fortune 50 market leaders to smaller companies specializing in information technology security—the
NCCoE applies standards and best practices to develop modular, adaptable example cybersecurity
solutions using commercially available technology. The NCCoE documents these example solutions in
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework
and details the steps needed for another entity to re-create the example solution. The NCCoE was
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County,
Maryland.

To learn more about the NCCoE, visit https://www.nccoe.nist.gov/. To learn more about NIST, visit
https://www.nist.gov.

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the
adoption of standards-based approaches to cybersecurity. They show members of the information
security community how to implement example solutions that help them align with relevant standards
and best practices, and provide users with the materials lists, configuration files, and other information
they need to implement a similar approach.

The documents in this series describe example implementations of cybersecurity practices that
businesses and other organizations may voluntarily adopt. These documents do not describe
regulations or mandatory practices, nor do they carry statutory authority.

A cloud workload is an abstraction of the actual instance of a functional application that is virtualized or
containerized to include compute, storage, and network resources. Organizations need to be able to
monitor, track, apply, and enforce their security and privacy policies on their cloud workloads, based on
business requirements, in a consistent, repeatable, and automated way. The goal of this project is to
develop a trusted cloud solution that will demonstrate how trusted compute pools leveraging hardware
roots of trust can provide the necessary security capabilities. These capabilities not only provide
assurance that cloud workloads are running on trusted hardware and in a trusted geolocation or logical
boundary, but also improve the protections for the data in the workloads and in the data flows between
workloads. The example solution leverages modern commercial off-the-shelf technology and cloud
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services to address lifting and shifting a typical multi-tier application between an organization-
controlled private cloud and a hybrid/public cloud over the internet.
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DOCUMENT CONVENTIONS

The terms “shall” and “shall not” indicate requirements to be followed strictly to conform to the
publication and from which no deviation is permitted. The terms “should” and “should not” indicate
that among several possibilities, one is recommended as particularly suitable without mentioning or
excluding others, or that a certain course of action is preferred but not necessarily required, or that (in
the negative form) a certain possibility or course of action is discouraged but not prohibited. The terms
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“may” and “need not” indicate a course of action permissible within the limits of the publication. The
terms “can” and “cannot” indicate a possibility and capability, whether material, physical, or causal.

This public review includes a call for information on essential patent claims (claims whose use would be
required for compliance with the guidance or requirements in this Information Technology Laboratory
(ITL) draft publication). Such guidance and/or requirements may be directly stated in this ITL Publication
or by reference to another publication. This call also includes disclosure, where known, of the existence
of pending U.S. or foreign patent applications relating to this ITL draft publication and of any relevant
unexpired U.S. or foreign patents.

ITL may require from the patent holder, or a party authorized to make assurances on its behalf, in writ-
ten or electronic form, either:

a) assurance in the form of a general disclaimer to the effect that such party does not hold and does not
currently intend holding any essential patent claim(s); or

b) assurance that a license to such essential patent claim(s) will be made available to applicants desiring
to utilize the license for the purpose of complying with the guidance or requirements in this ITL draft
publication either:

1. under reasonable terms and conditions that are demonstrably free of any unfair discrimination;
or

2. without compensation and under reasonable terms and conditions that are demonstrably free
of any unfair discrimination.

Such assurance shall indicate that the patent holder (or third party authorized to make assurances on its
behalf) will include in any documents transferring ownership of patents subject to the assurance, provi-
sions sufficient to ensure that the commitments in the assurance are binding on the transferee, and
that the transferee will similarly include appropriate provisions in the event of future transfers with the
goal of binding each successor-in-interest.

The assurance shall also indicate that it is intended to be binding on successors-in-interest regardless of
whether such provisions are included in the relevant transfer documents.

Such statements should be addressed to: trusted-cloud-nccoe@nist.gov
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The following volumes of this guide show information technology (IT) professionals and security
engineers how we implemented this example solution. We cover all of the products employed in this
reference design. We do not re-create the product manufacturers’ documentation, which is presumed
to be widely available. Rather, these volumes show how we incorporated the products together in our
environment.

Note: These are not comprehensive tutorials. There are many possible service and security configurations
for these products that are out of scope for this reference design.

1.1 Practice Guide Structure

This National Institute of Standards and Technology (NIST) Cybersecurity Practice Guide demonstrates a
standards-based reference design and provides users with the information they need to replicate a
trusted cloud solution using trusted compute pools leveraging hardware roots of trust to provide the
necessary security capabilities. This reference design is modular and can be deployed in whole or in part.

This guide contains three volumes:

= NIST SP 1800-19A: Executive Summary
= NIST SP 1800-19B: Approach, Architecture, and Security Characteristics — what we built and why

= NIST SP 1800-19C: How-To Guides — instructions for building the example solution (you are
here)

Depending on your role in your organization, you might use this guide in different ways:
Business decision makers, including chief security and technology officers, will be interested in the
Executive Summary, NIST SP 1800-19A, which describes the following topics:

= challenges that enterprises face in protecting cloud workloads in hybrid cloud models

= example solution built at the NCCoE

= benefits of adopting the example solution

Technology or security program managers who are concerned with how to identify, understand, assess,
and mitigate risk will be interested in NIST SP 1800-19B, which describes what we did and why. The
following sections will be of particular interest:

=  Section 3.4.3, Risk, describes the risk analysis we performed.

= Appendix A, Mappings, maps the security characteristics of this example solution to
cybersecurity standards and best practices.

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud laaS Environments 1
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You might share the Executive Summary, NIST SP 1800-19A, with your leadership team members to help
them understand the importance of adopting standards-based trusted compute pools in a hybrid cloud
model that provide expanded security capabilities.

IT professionals who want to implement an approach like this will find the whole practice guide useful.
You can use this How-To portion of the guide, NIST SP 1800-19C, to replicate all or parts of the build
created in our lab. This How-To portion of the guide provides specific product installation, configuration,
and integration instructions for implementing the example solution.

This guide assumes that IT professionals have experience implementing security products within the
enterprise. While we have used a suite of commercial products to address this challenge, this guide does
not endorse these particular products. Your organization can adopt this solution or one that adheres to
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing
parts of a trusted cloud implementation leveraging commercial off-the-shelf technology. Your
organization’s security experts should identify the products that will best integrate with your existing
tools and IT system infrastructure. We hope that you will seek products that are congruent with
applicable standards and best practices. Section 4.2, Technologies, in NIST SP 1800-198 lists the
products that we used and maps them to the cybersecurity controls provided by this reference solution.

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution. This is a
draft guide. We seek feedback on its contents and welcome your input. Comments, suggestions, and
success stories will improve subsequent versions of this guide. Please contribute your thoughts to
trusted-cloud-nccoe@nist.gov.

1.2 Build Overview

The NCCoE worked with its build team partners to create a lab demonstration environment that includes
all of the architectural components and functionality described in Section 4 of NIST SP 1800-198B. The
following use case scenarios were demonstrated in the lab environment:

Demonstrate control and visibility for the trusted hybrid cloud environment

Demonstrate control of workloads and data security

Demonstrate a workload security policy in a hybrid cloud

Demonstrate recovery from an unexpected infrastructure outage

Demonstrate providing visibility into network traffic patterns

A A T A

Demonstrate application zero trust

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud laaS Environments 2
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1.3 Typographic Conventions

The following table presents typographic conventions used in this volume.

Typeface/Symbol Meaning Example
Italics file names and path names; For language use and style guidance, see
references to documents that are the NCCoE Style Guide.
not hyperlinks; new terms; and
placeholders
Bold names of menus, options, command | Choose File > Edit.
buttons, and fields
Monospace command-line input, onscreen mkdir

computer output, sample code
examples, and status codes

Monospace Bold

command-line user input contrasted
with computer output

service sshd start

blue text

link to other parts of the document,
a web URL, or an email address

All publications from NIST’s NCCoE are
available at https://www.nccoe.nist.gov.

1.4 Logical Architecture Summary

At a high level, the trusted cloud architecture has three main pieces: a private cloud hosted at the
NCCoE, an instance of the public IBM Cloud Secure Virtualization (ICSV), and an Internet Protocol
Security (IPsec) virtual private network (VPN) that connects the two clouds to form a hybrid cloud.

The private on-premises cloud at the NCCoE consists of the following components:

= Hardware Security Module (HSM) for storing keys by Gemalto

= server, storage, and networking hardware by Dell EMC

= Intel processors in the Dell EMC servers

= compute, storage, and network virtualization capabilities by VMware

= asset tagging and policy enforcement, workload and storage encryption, and data scanning by

HyTrust

= multifactor authentication, network traffic monitoring, and dashboard and reporting by RSA

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud laaS Environments 3
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The ICSV instance consists of the following components:

= |BM-provisioned servers with Intel processors
= compute, storage, network virtualization with VMware components

= asset tagging and policy enforcement, and workload and storage encryption with HyTrust
components

The IPSec VPN established between the two clouds allows them to be part of the same management
domain, so that each component can be managed and utilized in the same fashion, which creates one
hybrid cloud. The workloads can be shifted or live-migrated between the two sites.

Figure 1-1 shows the high-level architecture. It depicts the four main components that comprise the
build:

= HSM component: This build utilizes HSMs to store sensitive keys within the environment.

= Management component: Identical functional management components are instantiated
within each cloud instance. At a minimum, each management component includes VMware
running the virtualization stack, HyTrust providing the asset tagging policy enforcement aspect,
and RSA providing network-visibility, dashboard, and reporting capabilities. The management
components are connected through the VPN to represent one logical management element.

= Compute component: The compute components host the tenant workload virtual machines
(VMs). Asset tagging is provisioned on the compute servers so that policy can be assigned and
enforced to ensure that tenant workloads reside on servers that meet specific regulatory
compliance requirements.

=  Workload component: The workload components include VMs, data storage, and networks
owned and operated by the tenant and data owner. Policies are applied to the workloads to
ensure that they can run only on servers that meet specific requirements, such as asset tag
policies.

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud laaS Environments 4
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Figure 1-1: High-Level Solution Architecture
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2 Dell EMC Product Installation and Configuration Guide

This section lists all prerequisites that must be met before the Dell EMC product installation and
configuration can take place. This includes dependencies on any other parts of the example solution. It is
recommended to download the latest security and hardening documentation from the Dell
Technologies support site for the following products:

= Dell PowerEdge R740xD

= Dell EMC Unity

= Dell Networking 53048/4048-ON Networking
= Dell Avamar

= Dell Data Domain

This section explains how to install and configure the Dell EMC products and hardening guides. It points
to existing documentation whenever possible, so this document only includes supplemental
information, such as configuration settings recommended for the example solution that differ from the
defaults.

2.1 Dell EMC Unity Hardening Guidance

Dell EMC utilizes a derivative of SUSE Linux 12 for its embedded operating system (OS) to manage the
hardware and provide storage device services. Dell EMC Unity has a simple command-line capability to
enable security hardening that meets the guidelines of the SUSE Linux 12 Security Technical
Implementation Guide (STIG). Some of the hardening steps to meet STIG requirements are turned on by
running service scripts.

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud laaS Environments 5
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Dell EMC Unity Data at Rest Encryption (D@RE) protects against unauthorized access to lost, stolen, or
failed drives by ensuring all sensitive user data on the system is encrypted as it is written to disk. It does
this through hardware-based encryption modules located in the serial attached SCSI (SAS) controllers
and 12Gb/s SAS |0 modules which encrypt data as it is written to the back-end drives, and decrypt data
as it is retrieved from these drives.

To enable and configure D@RE, first read the Dell EMC Unity: Data at Rest Encryption paper and follow
the instructions in these sections:

= Enabling D@RE
= Enabling External Key Management
=  Keystore Backup

= Audit Log and Checksum Retrieval

Next, configure the storage system to enable Federal Information Processing Standards (FIPS) 140-2
mode for the Transport Layer Security (TLS) modules that encrypt client management traffic. Directions
for doing so are in the “Management support for FIPS 140-2” section of Chapter 4 of the Dell EMC Unity
Family Security Configuration Guide. Finally, to enable STIG mode on the Dell EMC Unity system (for
physical deployments only), follow the three steps, in order, for hardening your storage system in the
“Manage STIG mode” section of Chapter 8 in the same Security Configuration Guide.

2.2 Dell Networking S4048-ON, S3048-ON, 0S9 Hardening

This section provides example configurations for release 9.14(1.0) on the S3048—0ON and shows how to
configure the Dell EMC Networking system in accordance with applicable DISA STIGs and DoD Unified
Capabilities Requirements (UCR) 2013 Errata-1. For more information on configuring the S3048-ON, see
the Dell EMC Configuration Guide for the S3048-ON System.

Configure the following features in the specified order. After you configure these features, configure the
Functionality and Interoperability (Layer 2 Access) or Functionality and Interoperability (Layer 3 Access)
features. For information about using the command line interface (CLI), see the Configuration
Fundamentals and Getting Started sections in the Dell Networking Configuration Guide for your
platform, or use the Dell Command Line Reference Guide for the S3048-ON System. To access all
documentation for release 9.14, go to https://www.dell.com/support/home/en-us/product-
support/product/dell-emc-0s-9/docs.

1. Set the hostname:

hostname NCCOE-54048-01

2. Configure password policies:
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https://www.delltechnologies.com/en-us/collaterals/unauth/white-papers/products/storage/h15090-dell-emc-unity-data-at-rest-encryption.pdf
https://www.delltechnologies.com/en-au/collaterals/unauth/technical-guides-support-information/products/storage/docu69321.pdf
https://www.delltechnologies.com/en-au/collaterals/unauth/technical-guides-support-information/products/storage/docu69321.pdf
https://downloads.dell.com/manuals/all-products/esuprt_networking_int/esuprt_networking_operating_systems/dell-emc-os-9_api-guide4_en-us.pdf
https://downloads.dell.com/manuals/all-products/esuprt_networking_int/esuprt_networking_operating_systems/dell-emc-os-9_api-guide6_en-us.pdf
https://www.dell.com/support/home/en-us/product-support/product/dell-emc-os-9/docs
https://www.dell.com/support/home/en-us/product-support/product/dell-emc-os-9/docs

338
339

340
341
342

343
344

345
346

347
348

349
350

351
352

353
354
355

356
357

358
359
360

361
362

363
364

365
366
367
368
369
370
371
372
373

DRAFT

a. Define the minimum security policy to create passwords. Ensure that the password
attributes match your organization’s security policy.

password-attributes min-length 15 character-restriction lower 2
character-restriction upper 2 character-restriction numeric 2 character-
restriction special 2

b. Set up the login lockout period to match your organization’s security policy.

password-attributes lockout-period 15

c. Enable password with highest privileges:

enable password level 15 <clear-text password>

To enable FIPS cryptography mode, enter this command:

fips mode enable

Note: Enable FIPS mode before you configure the features below. If you do not, the system will
clear some of the configuration, and you must reconfigure some of the features.

Note: If the system fails to transition to FIPS mode, the system is not in a compliant state.
Enable SSH server:

ip ssh server cipher aesl28-ctr aesl92-ctr aes256-ctr
ip ssh server enable
ip ssh server mac hmac-shal hmac-sha2-256

Disable telnet server:

no ip telnet server enable

Define content addressable memory (CAM) allocation and optimization. CAM is a type of
memory that stores information in the form of a lookup table. These CAM settings are required
to configure a conformant IPv4 and IPv6 solution.

cam-acl 12acl 2 ipvdacl 2 ipvbacl 4 ipv4gos 2 1l2goa 1 12pt 0 ipmacacl 0 vman-
gos cfmacl 0 fedgoval

Enforce authentication and authorization of users connecting to system through the console or
SSH, and then set the timer for terminating a session after 10 minutes of inactivity.

login authentication ucraaa console
exec-timeout 10 O

authorization exec ucraaa console
line vty O

login authentication ucraaa vty
exec-timeout 10 0

authorization exec ucraaa vty

line vty 1

login authentication ucraaa vty
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exec-timeout 10 0

authorization exec ucraaa vty
line vty 2

login authentication ucraaa vty
exec-timeout 10 O

authorization exec ucraaa vty
line vty 3

login authentication ucraaa vty
exec-timeout 10 O

authorization exec ucraaa vty
line vty 4

login authentication ucraaa vty
exec-timeout 10 0

authorization exec ucraaa vty
line vty 5

login authentication ucraaa vty
exec-timeout 10 O

authorization exec ucraaa vty
line vty 6

login authentication ucraaa vty
exec-timeout 10 0

authorization exec ucraaa vty
line vty 7

login authentication ucraaa vty
exec-timeout 10 0

authorization exec ucraaa vty
line vty 8

login authentication ucraaa vty
exec-timeout 10 O

authorization exec ucraaa vty
line vty 9

login authentication ucraaa vty
exec-timeout 10 0

authorization exec ucraaa vty

8. Define a role-based user supplying an encrypted password:

username admin password 7 888dc89dl1flbcaz2882895c1658£993e7 privilege 15

9. Limit open Transmission Control Protocol (TCP) connections by defining the wait duration for
TCP connections as nine seconds:

ip tcp reduced-syn-ack-wait
10. Define the IPv4 static route:

ip route 0.0.0.0/0 192.168.101.1

11. Configure IPv4 Open Shortest Path First (OSPF) routes:

router ospf 101
router-id 192.168.101.3
network 192.168.101.0/24 area 101
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12.

13.

14.

15.

16.

area 101 nssa default-information-originate
redistribute bgp 65001

Configure Media Access Control (MAC) settings:

mac-address-table station-move refresh-arp
mac-address-table agint-time 1000000

Configure system and audit log settings, such as syslog version, buffer size, logging server, and
coredump destination:

service timestamps log datetime localtime msec show-timezone
service timestamps debug datetime localtime msec show-timezone
|

logging coredump stack-unit
logging coredump stack-unit
logging coredump stack-unit
logging coredump stack-unit
logging coredump stack-unit

logging coredump stack-unit
|

o Uk W N

Set up the Network Time Protocol (NTP):

ntp server 192.168.4.10
ntp server 192.168.4.11

Configure the login banner text:

banner login "“CYou are accessing a U.S. Government (USG) Information System
(IS) that is

provided for USG-authorized use only.

By using this IS (which includes any device attached to this IS), you consent
to the following conditions:

-The USG routinely intercepts and monitors communications on this IS for
purposes including, but not limited to, penetration testing, COMSEC monitoring,
network operations and defense, personnel misconduct (PM), law enforcement
(LE), and counterintelligence (CI) investigations.

-At any time, the USG may inspect and seize data stored on this IS.
-Communications using, or data stored on, this IS are not private, are subject
to routine monitoring, interception, and search, and may be disclosed or used
for any USG-authorized purpose.

-This IS includes security measures (e.g., authentication and access controls)
to protect USG interests--not for your personal benefit or privacy.

-Not withstanding the above, using this IS does not constitute consent to PM,
LE or CI investigative searching or monitoring of the content of privileged
communications, or work product, related to personal representation or services
by attorneys, psychotherapists, or clergy, and their assistants. Such
communications and work product are private and confidential.”C

Configure the switch to securely bring the software image to its flash drive. Define where to up-
grade the software image to (flash drive) and where to boot the software image from.
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17.

18.

19.

20.

21.

22.

23.

24,

25.

boot system stack-unit 1 primary system://B
boot system stack-unit 1 secondary system://B

boot system stack-unit 1 default system://A
|

Disable Support Assist:

eula-consent support-assist reject

Configure redundancy:

redundancy auto-synchronize full

Configure the loopback interface for management traffic:

interface Loopback 0
description NCCOE-S4048-02
ip address 10.0.2.2/32

no shutdown
|

Enter the File Transfer Protocol (FTP) source interface, for example Loopback 1:

ip ftp source-interface loopback 1

Enter the clock timezone for your system:
clock timezone Eastern -5

clock summer-time Eastern recurring 2 Sun Mar 02:00 1 Sun Nov 02:00
I

To disable IP source routing, enter the following command:

no ip source-route

Configure reload behavior:

reload-type

boot-type normal-reload
config-scr-download enable
vendor-class-identifier W

Enable login statistics:

login concurrent-session limit 3

login statistics enable
I

Configure the management interface:

interface ManagementEthernet 1/1
description OOB_ MGMT
ip address 10.10.10.11/24
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2.2.1

no shutdown
|

Functionality and interoperability (layer 3 access)

This section describes how to configure functionality and interoperability using Layer 2. The example
configurations shown in the following sections are based on the requirements in UCR 2013 Errata 1.
Your site needs to update the configurations as the UCR requirements periodically change.

1.

Configure the Link Layer Discovery Protocol (LLDP):

protocol 1ldp

advertise dotl-tlv port-vlan-id

advertise dot3-tlv max-frame-size

advertise management-tlv management-address system-capabilities system-
description system-name

advertise interface-port-desc
|

The following configurations create aggregated links and were applied to interfaces to enable
link aggregation control protocol (LACP). The aggregated links were then subscribed to virtual
local area networks (VLANs). For complete information about this feature, see the Port Channel
Interfaces and Link Aggregation Control Protocol (LACP) sections in the Dell Networking Configu-
ration Guide and the Dell Networking Command Line Reference Guide.

interface Port-channel 64

description LAG to IB-MGMT switches

no ip address

switchport

vlt-peer-lag port-channel 64

no shutdown

|

interface Port-channel 67

no ip address

mtu 9216

portmode hybrid

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation
lacp fast-switchover

vlt-peer-lag port-channel 67

no shutdown

|

interface Port-channel 68

no ip address

mtu 9216

portmode hybrid

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation
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lacp fast-switchover

vlt-peer-lag port-channel 68

no shutdown

|

interface Port-channel 127
description VLTi

no ip address

channel-member fortyGigkE 1/51,1/52

no shutdown
|

Apply input and output policies to physical interfaces. The following are the configurations in

the NCCoE lab and can be run on the switch CLI as written to duplicate:

interface TenGigabitEthernet 1/1

description mgt-nccoe-esxi-01

no ip address

mtu 9216

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation

no shutdown

|

interface TenGigabitEthernet 1/2

description mgt-nccoe-esxi-02

no ip address

mtu 9216

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation

no shutdown

|

interface TenGigabitEthernet 1/3

description mgt-nccoe-esxi-03

no ip address

_ mtu 9216

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation

no shutdown

|

interface TenGigabitEthernet 1/4

description mgt-nccoe-esxi-04

no ip address

mtu 9216

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation

no shutdown

|

interface TenGigabitEthernet 1/5

description mgt-nccoe-esxi-01
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no ip address

mtu 9216

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation

no shutdown

!

interface TenGigabitEthernet 1/6

description mgt-nccoe-esxi-02

no ip address

mtu 9216

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation

no shutdown

|

interface TenGigabitEthernet 1/7

description mgt-nccoe-esxi-03

no ip address

mtu 9216

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation

no shutdown

!

interface TenGigabitEthernet 1/8

description mgt-nccoe-esxi-04

no ip address

mtu 9216

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation

no shutdown

!

interface TenGigabitEthernet 1/9

description comp-nccoe-esxi-01

no ip address

mtu 9216

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation

no shutdown

|

interface TenGigabitEthernet 1/10

description comp-nccoe-esxi-02

no ip address

mtu 9216

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation

no shutdown
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interface TenGigabitEthernet 1/11

description comp-nccoe-esxi-03

no ip address

mtu 9216

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation

no shutdown

|

interface TenGigabitEthernet 1/12

description comp-nccoe-esxi-04

no ip address

mtu 9216

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation

no shutdown

|

interface TenGigabitEthernet 1/13

description comp-nccoe-esxi-01

no ip address

mtu 9216

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation

no shutdown

|

interface TenGigabitEthernet 1/14

description comp-nccoe-esxi-02

no ip address

mtu 9216

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation

no shutdown

|

interface TenGigabitEthernet 1/15

description comp-nccoe-esxi-03

no ip address

mtu 9216

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation

no shutdown

|

interface TenGigabitEthernet 1/16

description comp-nccoe-esxi-04

no ip address

mtu 9216

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation
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no shutdown

!

interface TenGigabitEthernet 1/31
description TO-UNITY-ARRAY

no ip address

mtu 9216

!

port-channel-protocol LACP
port-channel 68 mode active

no shutdown

|

interface TenGigabitEthernet 1/32
description TO-UNITY-ARRAY

no ip address

mtu 9216

|

port-channel-protocol LACP
port-channel 67 mode active

no shutdown

!

interface TenGigabitEthernet 1/47
description NorthBound Firewal X5
no ip address

switchport

no shutdown

!

interface TenGigabitEthernet 1/48
description IB-MGMT Switch Stack Port 49
no ip address

|

port-channel-protocol LACP
port-channel 64 mode active

no shutdown

interface fortyGigE 1/51
description VLTi

no ip address

no shutdown

!

interface fortyGigE 1/52
description VLTi

no ip address

no shutdown

|

interface fortyGigE 1/53
description to Spine Switch 4 Port 54
ip address 192.168.1.1/31

no shutdown

|

interface fortyGigE 1/54
description to Spine Switch 3 Port 54
ip address 192.168.2.1/31

no shutdown
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|
interface Port-channel 64

description LAG to IB-MGMT Switches

no ip address

switchport

vlt-peer-lag port-channel 64

no shutdown

|

interface Port-channel 67

no ip address

mtu 9216

portmode hybrid

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation
lacp fast-switchover

vlt-peer-lag port-channel 67

no shutdown

|

interface Port-channel 68

no ip address

mtu 9216

portmode hybrid

switchport

spanning-tree rstp edge-port bpduguard shutdown-on-violation
spanning-tree 0 portfast bpduguard shutdown-on-violation
lacp fast-switchover

vlt-peer-lag port-channel 68

no shutdown

|

interface Port-channel 127

description VLTi

no ip address

channel-member fortyGigkE 1/51,1/52

no shutdown

|

interface Port-channel 128

no ip address

shutdown
|

Honor 802.1p markings on incoming traffic and assign them to a default queue
service-class dynamic dotlp

Include overhead fields in rate-metering calculations
gos-rate-adjust 20

2.2.2 VLANs

Define the network-specific VLAN interfaces. For complete information about this feature, see the
Virtual LANs (VLANSs) section in the Dell Networking Configuration Guide and the Dell Networking
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Command Line Reference Guide. The following are the configurations in the NCCoE lab and can be run
on the switch CLI as written to duplicate:

interface Vlan 1
luntagged Port-channel 67-68,127
|
interface Vlan 101

ip address 192.168.101.3/24
untagged TenGigabitEthernet 1/47
|

vrrp-group 101

virtual-address 192.168.101.2
no shutdown
!
interface Vlan 103

no ip address

shutdown
|
interface Vlan 104

description nccoe-m0l-vdsOl-managemnt
ip address 192.168.4.252/24
tagged TenGigabitEthernet 1/1-1/16,1/21
tagged Port-channel 64,127
|

vrrp-group 104

priority 254

virtual-address 192.168.4.254

no shutdown
|

interface Vlan 110
description nccoe-m0l-vdsOl-nfs
ip address 192.168.10.252/24
tagged TenGigabitEthernet 1/1-1/16,1/21
tagged Port-channel 67-68,127
|
vrrp-group 110
priority 254
virtual-address 192.168.10.254
no shutdown
|
interface Vlan 120
description nccoe-m0l-vdsOl-vmotion
ip address 192.168.20.252/24
tagged TenGigabitEthernet 1/1-1/8
tagged Port-channel 127
|
vrrp-group 120
priority 254
virtual-address 192.168.20.254

no shutdown
|

interface Vlan 130
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description nccoe-m0l-vdsOl-vsan
ip address 192.168.30.252/24
tagged TenGigabitEthernet 1/1-1/8
tagged Port-channel 127
|
vrrp-group 130
priority 254
virtual-address 192.168.30.254
no shutdown
|
interface Vlan 140
description nccoe-m0l-vdsOl-replication
ip address 192.168.40.252/24
tagged TenGigabitEthernet 1/1-1/8
tagged Port-channel 127
|
vrrp-group 140
priority 254
virtual-address 192.168.40.254
no shutdown
!
interface Vlan 150
description VTEP VLAN
ip address 192.168.50.252/24
tagged TenGigabitEthernet 1/1-1/16
tagged Port-channel 127
|
vrrp-group 150
priority 254
virtual-address 192.168.50.254
no shutdown
!
interface Vlan 160
description nccoe-m0l-vdsOl-uplink0O1l
ip address 192.168.60.252/24
tagged TenGigabitEthernet 1/1-1/16
!
vrrp-group 160
priority 254
virtual-address 192.168.60.254
no shutdown
!
interface Vlan 180
description nccoe-m0l-vdsOl-ext-management
no ip address
tagged TenGigabitEthernet 1/1-1/16
tagged Port-channel 127
no shutdown
!
interface Vlan 210
description nccoe-w0l-vdsOl-nfs
ip address 192.168.210.252/24
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tagged TenGigabitEthernet 1/1-1/16
tagged Port-channel 127
|

vrrp-group 210

priority 254

virtual-address 192.168.210.254
no shutdown
!
interface Vlan 220

description nccoe-w0l-vdsOl-vmotion
ip address 192.168.220.252/24
tagged TenGigabitEthernet 1/9-1/16
tagged Port-channel 127
!

vrrp-group 220

priority 254

virtual-address 192.168.220.254
no shutdown
!
interface Vlan 230

description nccoe-w0l-vdsOl-vsan
ip address 192.168.230.252/24
tagged TenGigabitEthernet 1/9-1/16
tagged Port-channel 127
!

vrrp-group 230

priority 254

virtual-address 192.168.230.254
no shutdown
|
interface Vlan 240

description VTEP VLAN

ip address 192.168.240.252/24
tagged TenGigabitEthernet 1/1-1/16
tagged Port-channel 127
|

vrrp-group 240

priority 254

virtual-address 192.168.240.254
no shutdown
|
interface Vlan 1000

description collapsed leaf edge bgp peering network
ip address 192.168.100.1/24

no shutdown
!
interface Vlan 1110

description nccoe-w0l-vdsOl-uplinkO1l
ip address 192.168.110.252/24
tagged TenGigabitEthernet 1/1-1/16
!

vrrp-group 111
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priority 254
virtual-address 192.168.110.254
no shutdown

2.3 Dell PowerEdge Hardening

Unified Extensible Firmware Interface (UEFI) Secure Boot is a technology that secures the boot process
by verifying if the drivers and OS loaders are signed by the key that is authorized by the firmware. When
enabled, Secure Boot makes sure that:

=  BIOS boot option is disabled.

=  Only UEFI-based OSes are supported for OS deployment in all management applications.

=  Only authenticated EFl images and OS loaders are started from UEFI firmware.

You can enable or disable the Secure Boot attribute locally or remotely using Dell EMC management
applications. Lifecycle Controller supports deploying an OS with the Secure Boot option only in the UEFI
boot mode.

There are two BIOS attributes that are associated with Secure Boot:

= Secure Boot — Displays if the Secure Boot is enabled or disabled.

= Secure Boot Policy — Allows you to specify the policy or digital signature that BIOS uses to
authenticate. The policy can be classified as:

e Standard — BIOS uses the default set of certificates to validate the drivers and OS loaders
during the boot process.

e Custom — BIOS uses the specific set of certificates that you import or delete from the
standard certificates to validate the drivers and OS loaders during the boot process.

Note: The secure boot policy settings made on BIOS can also be changed on the Lifecycle Controller
graphical user interface (GUI).

2.4 Avamar Security Hardening

Avamar servers running the SUSE Linux Enterprise Server (SLES) OS can implement various server
security hardening features. Avamar servers running the SLES OS offer a number of improved security
features, which are primarily targeted for customers needing to comply with DoD STIGs for Unix
requirements. The following are specific steps to harden different components and services on the
Avamar server. All come from Chapter 7 of the Dell EMC Avamar Product Security Guide.

1. Disabling Samba (under “Level-1 security hardening”)

2. Preventing unauthorized access to GRUB configuration (under “Level-1 security hardening”)
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Preventing the OS from loading USB storage (under “Level-1 security hardening”)
Updating OpenSSH (under “Level-3 security hardening”)

Disabling RPC (under “Level-3 security hardening”)

Configuring the firewall to block access to port 9443 (under “Level-3 security hardening”)

Changing file permissions (under “Level-3 security hardening”)

This section describes the steps and commands to configure the Gemalto Luna 6 HSM and create
partitions on it for networked servers to use.

3.1 Gemalto Luna 6 Initialization

The following commands are for initializing the system and configuring the Luna HSM networking. When
the system is logged into for the first time, the default user is admin and the password is PASSWORD. A
prompt is immediately presented upon successful login to change the default password. Once the
password is changed, run the following commands for configuration purposes:

1.

Set the time zone to US Eastern:

sysconf timezone set US/Eastern

Set the date/time format:

syscont time HH:MM YYYMMDD

Set the hostname:

net hostname TCHSM

Set the Domain Name System (DNS) server:

net dns add nameserver 172.16.1.11

Set the network interface card (NIC) configuration for ethO on the HSM:

net interface -device eth0 -ip 172.16.1.22 -netmask 255.255.255.0 -gateway
172.16.1.254

Perform the following steps to generate and use a new HSM server certificate:

1.

Generate the certificate:

sysconf regenCert
Bind the cert to ethO:

ntls bind eth0
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1013 3. Verify the status of Network Trust Links (NTLS):
1014 ntls show

1015  The following commands initialize the HSM and set up policies for logging in and which algorithms it can
1016 use:

1017 1. Initialize the HSM and set the login timeout:

1018 hsm PED timeout set -type -seconds 300

1019 2. Next, log in as Security Officer:

1020 hsm init -label NCCoE Lab

1021 3. Policy 12 controls non-FIPS compliant algorithms. Setting the value to zero disables any non-FIPS
1022 compliant algorithms:

1023 hsm changePolicy -policy 12 -v 0

1024 3.2 Create HSM Partition

1025 The following steps create the individual partition in the HSM that will be used for the HyTrust
1026 KeyControl cluster to use as its key management system (KMS):

1027 1. hsm login

1028 2. Create the HSM partition to be used for KeyControl:

1029 partition create -partition HyTrust KeyControl

1030 3. Set the password for the newly created partition:

1031 partition changePW -partition HyTrust KeyControl -newpw <new password> -oldpw
1032 <old password>

1033 4. Allow activation:

1034 partition changePolicy -partition HyTrust KeyControl -policy 22 -v 1
1035 5. Allow auto-activation:

1036 partition changePolicy -partition HyTrust KeyControl -policy 23 -v 1
1037 6. Activate the newly created partition:

1038 partition activate -partition HyTrust KeyControl

1039 7. Show partition serial number for high availability:

1040 partition show
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1041

1042  This build implemented the HyTrust KeyControl, DataControl, CloudControl, and CloudAdvisor
1043 appliances. The following subsections show how the installation and configurations were performed, as
1044  well as how they were integrated with other components in the build.

1045 4.1 HyTrust KeyControl Setup

1046 First, follow the directions on these pages:

1047 1. Installing KeyControl from an OVA Template (note: OVA stands for open virtual appliance)
1048 2. Configuring the First KeyControl Node (OVA Install)
1049 3. Adding a New KeyControl Node to an Existing Cluster (OVA Install)

1050 Next, in order to use the Gemalto Luna HSM as the KMS server to protect its keys, there must be
1051 connectivity between KeyControl and the HSM. To configure the HSM in KeyControls:

1052 1. Login tothe web user interface (Ul) and click the SETTINGS button.

1053 2. Once in the Settings menu, click on the “HSM Server Settings” link to configure the HSM.
1054 3. Enterin the following information for the Gemalto Luna HSM:

1055 e hostname or IP address

1056 e partition label that was created in the Gemalto steps

1057 e partition password

1058 e server certificate file

1059 e client name for this KeyControl server

1060 4. When the information is entered correctly, and the KeyControl server can communicate with
1061 and authenticate to the Gemalto HSM, the state will show as “ENABLED”.
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State

Hostname:

Pariftion Label

Partition Password

Server Cerlificale

Client Name

4.2 HyTrust DataControl Setup

Follow the directions on these pages:

1. Creating a Cloud VM Set

2.

Installing Policy Agent on Windows

3. Registering the Policy Agent Using the HyTrust Policy Agent GUI

4.

Encrypting a Disk Using the WebGUI

4.3 HyTrust CloudControl Appliance Setup

Follow the directions on these pages:

1.

Overview

Installing from an OVA File

Configuring the Management Interface

Configuring the Management Console

Configuring High Availability

a.

b.

HA Overview

High Availability Configuration Modes

High Availability Considerations and Limitations

High Availability Setup and Configuration

Default Configuration
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6. Adding Hosts to CloudControl
a. Protected Hosts
b. Adding a Host

7. Configuring Managed Hosts

8. Enabling a Good Known Host

9. Verifying and Updating Host Trust (and Host Icons Used in CloudControl)

For more information on PolicyTags provisioning and evaluation, see the “PolicyTags Provisioning”
section in chapter 6 of the Administration Guide for HyTrust CloudControl.

4.3.1 Provisioning PolicyTags

To provision the PolicyTags, you need to perform the following tasks:
1. Collect the UUID (Universally Unique Identifier) information for each Trusted host.
2. Generate and run the esxc1i commands for hardware provisioning for each Trusted host.
3. Verify that the PolicyTags are provisioned.

4.3.1.1 Collect UUIDs of Good Known Hosts (GKHs) and Trusted Hosts

The UUID information for the GKHs and Trusted hosts can be collected from the vCenter Managed
Object Browser (MOB). You will need to obtain the UUID for each GKH and Trusted host.

1. Loginto the vCenter Managed Object Browser at https://<VSPHERE URL>/mob.

2. Perform the following series of page selections to reach the host page for each of your Intel TXT-
enabled hosts:

Managed Object ID (page) NAME (selection row) VALUE (link to select)
Servicelnstance Content content

content rootFolder group-d#

group-d# childEntity datacenter-#
datacenter-# hostFolder group-h#

group-h# childEntity domain-c#

domain-c# host host-## (Intel TXT host)

3. Onthe Hosts page, click Summary.

4. On the Summary page, click Hardware. The Hardware page contains the UUID information.
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5.

Repeat this for each Trusted host.

4.3.1.2 Generate esxcli Commands

Use the CloudControl cli to generate esxcl1i commands that can be used for hardware provisioning.

1.

Log into CloudControl as the ascadminuser, and run the following command:

asc tas --export-certs

This generates a file in /tmp in the following format: export--xxxx-xx-xxx.tgz

Navigate to the /tmp folder and extract the file using the following command:

tar -xvf exXport--xxxx-xx-xxx.tgz

The extraction process lists several files, including the shal.bin for each Trusted ESXi host.

Example:

export--2018-08-27T23-44-43%/6aab6af76/14£6/42e8/b452/6aabatf716-14£6-42e8-b452~
dc27fe259%ela/system—--6aa6af76-14f6-42e8-b452-dc27fe25%la.der

export--2018-08-27T23-44-437/6aa6af76/14£f6/42e8/b452/6aabaf76-14f6-42e8-b452~
dc27fe259%ela/system--6aa6af716-14f6-42e8-b452-dc27fe25%1la.shal.bin

export--2018-08-27T23-44-437/6aa6af76/14£f6/42e8/b452/6aabaf76-14f6-42e8-b452~
dc27fe259%ela/system--6aa6af76-14f6-42e8-b452-dc27fe259%la.sha256.bin

export--2018-08-27T23-44-43%/6aab6af76/14£6/42e8/b452/6aabatf716-14£6-42e8-b452~
dc27fe259%ela/system--6aa6af76-14£6-42e8-b452-dc27fe259%la.metadata.txt

export--2018-08-27T23-44-437/dddfda66/314e/4378/8£f4d/dddfda66-314e-4378-8f4d-
060b5d885038/system--dddfda66-314e-4378-8f4d-06005d885038.der

export--2018-08-27T23-44-437/dddfda66/314e/4378/8£f4d/dddfda66-314e-4378-8f4d-
060b5d885038/system--dddfda66-314e-4378-8f4d-060b5d885038.shal.bin

export--2018-08-27T23-44-437/dddfda66/314e/4378/8£f4d/dddfda66-314e-4378-8f4d-
060b5d885038/system--dddfda66-314e-4378-8f4d-06005d885038.sha256.bin

export--2018-08-27T23-44-437/dddfda66/314e/4378/8f4d/dddfda66-314e-4378-8f4d-
060b5d885038/system--dddfda66-314e-4378-8f4d-060b5d885038 .metadata.txt

Navigate to the extracted directory, for example:

cd /tmp/export—-—xxXxX—xX—XxX

At the prompt, type the following command:

grep -E -- '""(id]|subject)" : ' json.dump | grep -Al '<Trusted-Host-UUID> '
This command returns the “subject” and the “id.” Example:

"subject" : "4c4c4544-0032-3010-8035-b5c04£333832",

"id" : "6aa6af76-14f6-42e8-b452-dc27fe25%1a"

Run the following hexdump command for each Trusted host, where <shal.bin file path> matches
the “id” for the specific host:
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1136 hexdump -e '"esxcli hardware tpm tag set --data=" 20/1 "%1.2x" ";\n"' <shal.bin
1137 file path>

1138 This returns the esxc1i command.

1139 Example:

1140 hexdump -e '"esxcli hardware tpm tag set --data=" 20/1 "%1.2x" ";\n"'

1141 6aab6af76/14f6/42e8/b452/6aabaf76-14f6-42e8-b452-dc27fe259%la/system--6aabaf76-
1142 14f6-42e8-b452-dc27fe259%la.shal.bin

1143 esxcli hardware tpm tag set --data=46f048ced4lafdfa686e4c00£9fd67a2b71d1c749;

1144  4.3.1.3 Run esxcli Commands

1145 Run the esxc1i commands for each Trusted host to provision the hardware tags.

1146 1. Putthe Trusted host into maintenance mode.

1147 2. Loginto the ESXi host as root.

1148 3. Run the specific esxc1i command for the Trusted host. The command is part of the hexdump
1149 output.

1150 Example:

1151 esxcli hardware tpm tag set --data=46f048ced4lafdfa686e4c00f9fd67a2b71d1lc749;
1152 4. Restart the ESXi host. The host should still be in maintenance mode.

1153  4.3.2 Policy Interaction

1154  See the Policy Interaction webpage for more information on how policy enforcement works.

1155 4.4 HyTrust CloudAdvisor Appliance Setup

1156 Follow the directions on these pages:

1157 1. Deploying CloudAdvisor

1158 2. Configuring the CloudAdvisor Virtual Appliance
1159 3. Setting Up CloudAdvisor

1160 4. Adding VMs to Inventory

1161

1162  This section covers all the aspects of installing and configuring the IBM products used to build the
1163 example solution. Note that the information in this section reflects product and service names, features,
1164  options, and configurations as of when the build was performed. The IBM products in this section are
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cloud-based with web-based documentation, and they do not use versioning conventions, so it is not
possible to reference the documentation that was used during this build. As of this writing, the latest
information from IBM is available through the IBM Cloud for VMware Solutions site at
https://www.ibm.com/cloud/vmware.

5.1 ICSV Deployment

IBM Cloud Secure Virtualization (ICSV) combines the power of IBM Cloud, VMware Cloud Foundation,
HyTrust security software, and Intel TXT-enabled hardware to protect virtualized workloads. ICSV is
deployed on the IBM Cloud infrastructure according to a VMware, HyTrust, IBM, and Intel-validated
design reference architecture. IBM Cloud Secure Virtualization is initially deployed as a four-node cluster
within the choice of clients of available IBM Cloud Data Centers worldwide. Below is a reference
architecture for ICSV that shows the separation between IBM Cloud services, ICSV provisioned
infrastructure, and tenant VMs. ICSV utilizes the IBM Cloud Services Network to enable provisioning the
IBM Cloud Private Network to a customer, which in turn protects the virtualized workloads.
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To deploy the ICSV reference architecture stack, IBM has streamlined the process in three phases for the
customer.

5.1.1 Pre-deployment

This phase starts after the customer has agreed to purchase the ICSV stack in the IBM cloud and has
identified the use cases using a workshop or IBM Garage methodology. For the NCCoE project, we had a
good understanding of the use case and the capabilities provided by ICSV. To achieve success in all three
phases, the IBM Services team filled out Table 5-1 and Table 5-2. The information provided in each table
helped us with decisions in later steps.
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1186  Table 5-1: Example of IBM Cloud Contact Information Template

Name Email Address Phone Number

Client Sponsor

Client Technical Lead

Client Oversight

Client Sales Engineer

IBM Account Exec

IBM Sales Contact

IBM OM Contact

IBM Program Manager (PM)

IBM Consultant

Other IBMers

Vendors info (if applicable)

1187  Table 5-2: ICSV Requirement & Deployment Template

Client Input Variables Choices Example Values
SoftLayer user id <user_name> from IAAS
SoftLayer APl key <user_key> from IAAS
Deployment - VMware Cloud Foundation (VCF) VCF or VCS VCS

or vCenter Server (VCS)

VCS deployment details

Instance name - TrustedCld

# of hosts (min. 3) 3t020 4

Instance Primary or Secondary Primary

Host configuration Small, Medium, Large, | Custom
Custom

Cores 16, 24, 28, 36 24
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Client Input Variables

Choices

Example Values

Intel core base 2.1,2.2,2.3GHz 2.2 GHz

RAM 64 GB-1.5TB 256 GB

Data center location Dallas, DC, Boulder, Dallas

etc.

Data storage NFS or VSAN VSAN

Size of each data storage 1,2,4,8,12TB 2TB

Performance of file shares 2,4,1010PS/GB NA

NFS version - v3.0 or v4.1 for shared drives NA

Windows AD VSI OR VM VM

Host prefix - EsxiO

Domain name (used in Windows AD) - nccoe.lab

Sub domain (used by VM) - icsv

VM License BYO or Purchase Purchase
VM Vcenter Server License - Standard
VM vSphere License - Enterprise Plus

VM NSX License - Enterprise

Services to be added

Veeam Yes / No NO

F5 Yes / No NO

Fortinet Security Appliance Yes / No NO

Fortinet Virtual Appliance Yes / No NO

Zerto version 5.0 Yes / No NO

HyTrust DataControl Yes / No YES

HyTrust CloudControl Yes / No YES

IBM Spectrum Protect Plus Yes / No NO

5.1.2 Automation deployment

The following are steps for ordering an ICSV instance through the IBM portal.

1. Loginto the IBM Cloud infrastructure customer portal at https://console.ng.bluemix.net/cata-

log/.
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1192 2. From the top left corner, select the “Hamburger” menu, then select VMware from the drop-
1193 down menu on the left side.

1194 3. Click on Settings and make sure the correct application programming interface (API) key is en-
1195 tered before provisioning the solution.

1196 4, On the IBM Cloud for VMware Solutions screen, select VMware vCenter Server on IBM Cloud.
1197 5. On the next screen, select vCenter Server and click the Create button.

1198 6. Inthe next window, type in the Instance Name and make sure Primary Instance is highlighted
1199 for Instance type. For the Licensing options, select Include with purchase for all of them. For the
1200 NSX License, select Enterprise from the drop-down menu.

1201 7. Under Bare Metal Server:

1202 a. For the Data Center Location, open the drop-down menu for NA South and select
1203 DALO9.

1204 b. Select Customized since our workload needs a virtual storage area network (VSAN),
1205 which requires a minimum of a four-node cluster.

1206 8. Under Storage:

1207 a. Select vSan Storage.

1208 b. Set the Disk Type and Size for vSAN Capacity Disks to 1.9 TB SSD SED.

1209 c. Select 2 from the drop-down menu for the Number of vSAN Capacity Disks.

1210 d. For vSAN License, select Include with purchase and then choose Enterprise from the
1211 drop-down menu.
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Preconfigured

tel Xeon E5-2620 v4 Dual Intel Xe« 5-2650 v4 Dual Intel Xeon E5-26 4 Dual Intel Xeon ar 411

Processo

16 Cores 24 Cores 28 Cores 16 Cores
2.1GHz 2.2 GHz 2.6 GHz 2.1 GHz
RAM
256 GB 64 GB _. 1578

Number of Bare Metal Servers (i

Storage

VSAN Storage NFS Storage

Disk Type and Size for vSAN Capacity Disks Number of vSAN Capacity Disks
[L.9 TB 55D SED - 2 & -
et e sy-festustomized hardware

9. For the Network Interface, enter the following:

a. Hostname Prefix: esxi

b. Subdomain Label: icsv

¢. Domain Name: nccoe.lab
10. Select Order New VLANSs.

11. Under DNS Configuration, select Two highly available dedicated Windows Server VMs on the
management cluster.

12. Under Services, remove Veeam on IBM Cloud 9.5 and select HyTrust CloudControl on IBM
Cloud 5.3 and HyTrust DataControl on IBM Cloud 4.1.

13. Click on the Provision button in the bottom right-hand corner. This will begin the provisioning
process for the selected topology. It can take roughly 24 hours to complete the automation de-
ployment. Once deployment has completed, you should receive an email notification.

5.1.3 Post-deployment

This information is needed to set up HyTrust CloudControl (HTCC) to interact with Windows AD and
vCenter. The IBM Service team will set up HTCC so it is ready for HyTrust configuration based on the use
cases required by the client. Table 5-3 shows examples of HTCC configuration parameters.
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Table 5-3: Examples of HTCC Configuration Parameters

Client Input Variables

SMTP Server - for email notifica-
tions

Choices

Point to company or enable third
party sendgrid

Example Values

sendgrid

SNMP Server

NTP Server (provided by SL)

Use default (10.0.77.54), unless spec-
ified

10.0.77.54 (time.ser-
vice.networklayer.co

m)

Windows AD Groups and Users

Group / Users

HTCC Super Admin group

ht_superadmin_users

ht_superadmin_user

S

User in: ht_superadmin_users (Full
Admin)

Administrator

Administrator

User: ht_ldap_svc
HTCC to AD login user

ht_ldap_svc unless specified by client

ht_ldap_svc

User: ht_vcenter_svc
HTCC to vCenter login user

ht_vcenter_svc unless specified by
client

ht_vcenter_svc

H/W Policy tags

Country (from BMXI portal, as dis- | Country Name USA

played)

State/Province State or Province Name DAL

Physical Data Center (PDC) Location (IBM Cloud Data Center DAL09
name as displayed)

Region Region where data center is located South West

Classification (User ID-Client name)

Custom

The IBM services team gathers information from the client, such as the examples in Table 5-4, after
understanding the use cases. The information will be used to configure HyTrust, VMware, and Intel
TPM/TXT to enforce workload rules and policy. Once post-deployment is completed, the IBM services
team will perform a verification test and deliver the asset to the client.
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Table 5-4: Examples of Additional HTCC Configuration Parameters

Client Input Variables

Choices

Example Values

SMTP Server - for email notifications | Point to company or enable | sendgrid

third party sendgrid
SNMP Server ? ?
HyTrust H/W TPM Policy Tags
HTCC Compliance Templates - Cus-
tom
Name Based on PClI, NIST, ...
HTCC Scheduled Events
Name Template or Label
HTCC Policy Labels
Name Template
HTCC Roles
Default Roles
Users
ASC_ARCAdmin default ASC_ARCAdmin
ASC_ARCAssessor default ASC_ARCAssessor
ASC_ApplAdmin default ASC_ApplAdmin
ASC_BackupAdmin default ASC_BackupAdmin
ASC_BasiclLogin default ASC_BasiclLogin
ASC_CoreApplAdmin default ASC_CoreApplAdmin
ASC_DCAdmin default ASC_DCAdmin
ASC_ESXMAdmin default ASC_ESXMAdmin
ASC_NetworkAdmin default ASC_NetworkAdmin
ASC_PolicyAdmin default ASC_PolicyAdmin
ASC_RoleAdmin default ASC_RoleAdmin
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Client Input Variables

Choices

Example Values

ASC_StorageAdmin default ASC_StorageAdmin
ASC_SuperAdmin default ASC_SuperAdmin
ASC_ThirdParty default ASC_ThirdParty
ASC_UCSLogin default ASC_UCSLogin
ASC_VIAdmin default ASC_VIAdmin
ASC_VMPowerUser default ASC_VMPowerUser
ASC_VMUser default ASC_VMUser
Groups

ASC_ARCAdmin default ASC_ARCAdmin
ASC_ARCAssessor default ASC_ARCAssessor
ASC_ApplAdmin default ASC_ApplAdmin
ASC_BackupAdmin default ASC_BackupAdmin
ASC_BasiclLogin default ASC_BasiclLogin
ASC_CoreApplAdmin default ASC_CoreApplAdmin
ASC_DCAdmin default ASC_DCAdmin
ASC_ESXMAdmin default ASC_ESXMAdmin
ASC_NetworkAdmin default ASC_NetworkAdmin
ASC_PolicyAdmin default ASC_PolicyAdmin
ASC_RoleAdmin default ASC_RoleAdmin
ASC_StorageAdmin default ASC_StorageAdmin
ASC_SuperAdmin default ASC_SuperAdmin
ASC_ThirdParty default ASC_ThirdParty
ASC_UCSLogin default ASC_UCSLogin
ASC_VIAdmin default ASC_VIAdmin
ASC_VMPowerUser default ASC_VMPowerUser
ASC_VMUser default ASC_VMUser
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1234 5.2 Enable Hardware Root of Trust on ICSV Servers

1235 In order to leverage the ICSV instance for hardware roots of trust, steps must be taken to enable these
1236  features within the server BIOS, as well as ensuring features in the VMware products are enabled to
1237  access and leverage these measurements.

1238 5.2.1 Enable Managed Object Browser (MOB) for each ESXi Server

1239 1. Open the vSphere Client and navigate to the relevant host.

1240 2. Click on the Configure tab.

1241 3. On the left-hand side under Software, click on System, then Advanced System Settings.

1242 4. Click on the Edit button.

1243 5. Modify or add the configuration to enable MOB: Config.HostAgent.plugins.solo.enableMob (set
1244 value to True).

1245 6. To confirm that MOB has been enabled on the host, open http://x.x.x.x/mob, where x.x.x.x is
1246 the IP address of the ESX Server.

1247  5.2.2 Enable TPM/TXT on SuperMicro hosts

1248 1. From the vCenter console, enter the ESX host(s) in maintenance mode.

1249 2. Loginto your IBM Cloud console and open a support ticket. In the ticket, specify the following:
1250 a. ESX host(s) you want them to work on. You can have support work on multiple hosts as
1251 long as you have the minimum running as required by your instance—minimum of three
1252 hosts for instances that have VSAN, otherwise two hosts.

1253 b. Enter ticket description as follows:

1254 < Start of ticket description >

1255 We need your assistance to enable TPM/TXT in the BIOS for this IBM Cloud Secure

1256 Virtualization (ICSV) instance.

1257 Please enable the TPM/TXT flags in the BIOS, following the steps in the exact order
1258 specified:

1259 1. Reboot the following host(s) specified below and enter into BIOS — <provide the list
1260 of hosts again here for clarity.>
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5.

2. Goto Advanced ‘Trusted Computing’. If TPM cannot be cleared in the Pending
Operations option, then reboot to BIOS and enable TPM only. You will need this to
clear TPM in the next reboot. Press F4 to save and exit.

3. Onreboot, again go to BIOS and go to Advanced ‘Trusted Computing’. Clear TXT.
This will clear TPM and TXT. Press F4 to save and exit.

4. On reboot go to BIOS and enable TPM only. Press F4 to save and exit. Do not
enable TPM and TXT in the same reboot. They have to be enabled in sequence.

5. Onreboot, again go to BIOS and now enable TXT. The TPM should have been
enabled from last step. Press F4 to save and exit.

6. Letthe reboot continue to boot to ESX.

Please let me know when you have done this successfully.
< End of ticket description >

c. Once the support person returns the ticket with the task completed, continue with the
tasks below.

From the vCenter console, exit maintenance mode. You may need to connect the ESX hosts
again if the host got disconnected.

From the vSphere web client or vSphere client, disconnect the host and then connect the host
back. This is needed to have the ESXi host re-read the TPM settings.

Check the vCenter MOB to check if TPM/TXT is enabled.

At a minimum, there must be three hosts up in instances that have VSAN. So make sure you only work
on hosts that will ensure this requirement is met. Ideally, work on one host at a time.

5.2.3
1.

2.

Enable TPM/TXT in IBM Cloud

Through vCenter, place the ESXi host in maintenance mode.
Reboot the ESXi server by pressing the F12 key in the iKVM viewer.

Once the server reboots, access the BIOS. Disable the TPM Provision Support, the TXT Support,
and the TPM State, then Save & Exit.

Reboot the server all the way to the ESXi OS level.
Reboot the server again using the F12 key.

Make sure the OS is not loaded, and access the BIOS. Set the TPM State to Enabled, then Save &
Exit.
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1291 7. Let the system boot up, but access the BIOS before the OS is loaded. If the system boots the OS,
1292 you will have to do the above steps again.

1293 8. Enable TXT Support in the BIOS, then Save & Exit.

1294 9. Boot the server to OS hypervisor level.

1295 5.2.4 Validate the TPM/TXT is enabled

1296 1. SSHinto the ESX host as root and run the following command:
1297 zcat /var/log/boot.gz | grep -I tpm

1298 This should show if the TPM library was loaded.

1299 2. Other commands to check are:

1300 vmkload mod -1 | grep tpm

1301 grep -i tpm /var/log/hostd.log | less -S

1302 3. Asaroot user, run the following command:

1303 esxcli hardware trustedboot get

1304 It should show two answers, and both should be true.

1305 5.2.5 Check the vCenter MOB to see if the TPM/TXT is enabled

1306 1. Open a browser with https://<vCenter-console-IP address>/mob to bring the vCenter MOB (do
1307 not use the individual ESXi host MOB). Authenticate using the vCenter credential.
1308 2. Click on different resources of the MOB in the steps shown below:
1309 a. Click on content.
1310 b. Search for group-d1 (Datacenters) and click on it.
licenseManager ManagedObjectReference:LicenseManager | LicenseManager
localizationManager ManagedObjectReference:LocalizationManager | LocalizationManager
overheadMemoryManager ManagedObjectReference:OverheadMemoryManager | OverheadMemoryManger
ovfManager ManagedObjectReference:OvfManager | OvfManager
perfManager ManagedObjectReference:PerformanceManager | PerfMgr
propertyCollector ManagedObjectReference:PropertyCollector | propertyCollector
rootFolder | ManagedObjectReference:Folder ||gr0up—é:|1 (Datacenters)
scheduledTaskManager ManagedObjectReference: ScheduledTaskManager SchedﬂdTaskManager
1311 c. Find datacenter-2 (SDDC-Datacenter) and click on it.
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d. Search for group-h4 (host) and click on it.
e. Search for domain-c7 (SDDC-Cluster) and click on it.
f. Search for host, and you will see all the hosts listed with their host names.

host ManagedObjectReference:HostSystem[] | host-29 (hostZ.securekSs.ibm.local)‘"“"-‘
host-34 (host3.securek8s.ibm.local) 44—
host-35 (host0.securek8s.ibm.local) @4——
host-36 (hostl.securek8s.ibm.local) f——m—

g. Click on the host that you need to validate. In our demo, we are checking hostl.se-
curek8s.ibm.local.

h. Search for method QueryTpmAttestationReport and click on it to invoke the method.

i. Click on Invoke Method.

5.2.6 Set up Active Directory users and groups

In this part of the setup, you will create several new organizational units. Remember that this procedure
uses a Windows 2012 server and Microsoft AD to illustrate the steps. Your environment and your
specific steps might be different. This section assumes actions are being performed from the ICSV
Microsoft AD server. Alternatively, you can follow these steps to set up AD. Note that the values in the
screen shots will be different than your values.

1. In Windows Server, start the Server Manager, if not already started.
2. From the Server Manager window, select Tools -> Active Directory Users and Computers.

3. Right-click on your domain that has been created based on the instance name you provided by
Windows AD deployment (for VCS) or during VCF deployment creation. For our demo, it is
demo3VCS.local. Select New -> Organizational Unit. You should create the new OU.
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= Active Directory Users and Computers
File Action  “iew Help

e rE e Bz B 2 RETE%R

[ Active Directary Users and Corn || Mame Type Description

B Saved Queries | Builtin builtinDarmain

4 ] derno3ves local I 1 Computers Container Default container for up...
- - Builtin 2| Domain Con... Organizational.. Default container for do..,
b - Cormnputers | FareignSecu... Container Default container for sec,.,
b = Darnain Controllers | Managed Se.. Container Default container far ma..,
4 - ForeignSecurityPrincipal: 1 Users Container Default container for up..,
[ || Managed Service &ccour
B | Users

4. Enter HyTrust as the name of the new unit. Right-click on the HyTrust organizational unit, select
New -> Organizational Unit, and give the name of Groups.

5. Right-click again on the HyTrust organizational unit, select New -> Organizational Unit, and give
the name of Users. This group will be used to allow a user to communicate between HTCC and
AD. The directory hierarchy should now look similar to this:

] fctive Directory Users and Com|| Name Type Description

B [ Saved Cueries 2 Groups Organizational..,

4 53 demalveslocal 31 Users Organizatianal..,

| Builtin

| Computers

2| Domain Contrallers

| Foreign3ecurityPrincipal:

3 HyTrust
3 Groups

b.vvva""-,

2| Users

| Managed Service &ccour
B Users

6. Add two users to the Users group. To do this, right-click on the HyTrust/Users organizational
unit and select New -> User.

7. The first user is the primary user account that will be used to communicate between HTCC and
AD. In the pop-up screen for users, enter user information as appropriate. The screen might look
like this:

Full name: HyTrust LDAP Lookup

User logon name: ht_ldap_svc
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2

Last narne: |

Full narme: HuTruzst LDAP Lookup

Firgt name: || | Initials: I:l

|Jzer logon name:

Mew Object - User -|

Create in.  demodves local/HyT rust/Users

Ihl_ldap_svc I | | Edermodves local W |

|dzer logon name [prewindows 2000]:

| demodvicsh | | ht_ldap_svi |

< Back | et = || Cahicel |

S

8. Click Next to go to the user password screen. It asks you to establish a password and some pass-
word options for the user. Enter or verify these fields:

a.

e.

Enter and confirm a password for the user. The password needs to have at least one up-
per case letter, otherwise the user will not be created. Note the password in the deploy-
ment spreadsheet.

Uncheck this option: User must change password at next logon.
Check this option: Password never expires.
Click Next.

Verify the information and finish.

9. The second user will be used as the service account when HTCC interacts with vCenter. You
could use the Administrator@vsphere.local account, but best practice is to create a specific ser-
vice account in AD and use that. Create the second user (in the same way as the first user) with
the following values:

Full name: HyTrust VCenter svc account

User logon name: ht_vcenter_svc

Ensure that the password never expires.

10. You will now create two subgroups under Groups.
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a. First, right-click on the Groups organizational unit and select New -> Group.

b. When prompted, enter a name for the new group: bcadmins. Later, you will tell HTDC to
use this group when communicating with HTCC to verify boundary checks. Keep the rest
of the options (Group scope and type) the default values as shown below. Press OK to
create the group.

Mew Object - Group
EIR_ Createin:  demo3vcs.local/Hy TrustiGroups
1

GaFaUp Name:
beadrmins| |

Garoup name (pre-Windows 20007

| bradmins |
(Group sCcope Group bvpe
() Domain local (®) Security
(#® Global () Diskribution
() Universal

c. Right-click again on the Groups organizational unit and select New -> Group.

d. When prompted, enter a name for this group: ht_superadmin_users and press OK.
Later, you will tell HTCC to use this group to specify administrative users of HTCC.

11. You will now add members to the superadmin group.
a. To do this, right-click on the ht_superadmin_users group, and select Properties.
b. Inthe pop-up window, select the Members tab, then click Add.

c. Inthe next pop-up screen, enter an object name Administrator, and click on Check
Names. If no error is returned, click OK.
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Select Users, Contacts, Computers, Service Accounts, or Groups -

Select thiz object type:

|L|$ers, Service Accounts, Groups, or Other objects | | Object Types... |

From thiz location:

|demn3vcf.|ocal || Locations... |

Enter the object names to select [examples]:

Adrninigtrator ]: I Check Names I

J—

o] [ G|

12. Close the AD control panel.

You are now ready to set up HTCC authentication to work with AD, as described in the next procedure.

5.2.7 Join vCenter to the AD domain

We need to integrate the AD domain into vCenter so that we can later give the AD HyTrust service
account vCenter permissions. You first have to join the vCenter to the AD domain, and then add the AD
user to vCenter. Note that this is already done for VCS and VCF. However, you may want to check using
the instructions below.

1. To check if vCenter is already joined to the AD domain, SSH into PSC.

2. Run the following command:

/opt/likewise/bin/domainjoin-cli query

If the output indicates it’s already joined, you can skip the rest of this section (5.2.7).
3. Ifit’s not already joined, run the following command to join it:

/opt/likewise/bin/domainjoin-cli Jjoin <domain-name> <AD Administrator user>
<password>

Example:
/opt/likewise/bin/domainjoin-cli Jjoin demo3vcs.local Administrator PasswOrd
Output:

Joining to AD Domain: demo3vcs.local

With Computer DNS Name: psc.demo3vcs.local

SUCCESS
Then reboot.

4. SSH into PSC again and verify that the join has succeeded by issuing the following command:
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/opt/likewise/bin/domainjoin-cli query
5.2.8 Add AD HyTrust-vCenter service user to vCenter as Administrator
This is for both the VCS and VCF instances.

1. Inthe vSphere Web Client, go to Administration and then Users and Groups. Click on Groups,
then Administrators, and select the Group Members Add icon.

vmware: vSphere Web Client  #=

Navigator X 5 vCenter Users and Groups
4 System Configurat... ° Users  Solution Users I Groups I
Jd 17 %
~ Access Control
Group Name Domain
Roles
ComponentManager.Administrators vsphere.local
Bz SRS LicenseSemnice Administrators vsphere local
~ Single Sign-On Administrators vsphare.local
Users and Groups
Caonfiguration " i
~ Licensing

Group Members

Licenses
Reports

T

S S T

2. Inthe Add Principals panel, select the Windows AD Domain (demo.local in our example), scroll
down and select the user ht_vcenter_svc user (that was created in Windows AD), and click on
the Add button. That user should appear in the Users list. Then press the OK button.
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Add Principals

Select users from the list or type names in the Users text box. Click Check names to
validate your entries against the directory.

Domain: l demo.local I |v|

Users and Groups

| Show Users First |v| [ @ Search

User/Group 2 a Desoiption/Full name

|E] ht_vcenter_svc | HyTrust VCenter svc account “
& krbtgt
Eﬂ PSCE
.ﬁ Access Control Assistance Operato...  Members of this group can remotely qu...
i Account Operators Members can administer domain user ...
ﬁ Administrators Administrators have complete and unr...
AL Allowed RONC Password Renlicati Memhers in this aronn can have their n M

Adh
[, ]

Users: |demo.local%ht_vcenter_svc |
Groups: | |

Separate multiple names with semicolons | check names

[ OK ][ Cancel ]

You have successfully added the Windows AD HyTrust vCenter LDAP id as part of the Administrator
group. This id will be used for all interaction between HTCC and vCenter, when the vCenter is added to

HTCC.

5.2.9
1

2.

Add AD HyTrust-vCenter service user to vCenter Global Permissions

Go to the vCenter web client. Under Administration, click on Global Permissions.

Add the AD user for the HyTrust-vCenter service, ht_vcenter_svc, and give it Administration per-
mission.

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud laaS Environments 46



1409

1410
1411
1412
1413

1414
1415

1416
1417
1418

1419
1420

1421
1422

DRAFT

Select Users/Groups 2%

Select users from the list or type names in the Users text box. Click Check names to
validate your entries against the directory.

Domain: I demodvcs local |v| I
| Show Users First | - | Q
User'Group 2 a Desoiption/Full name
& demo_powervmuser *

& demo_vmuser
& Guest
Ed hi_ldap_svc HyTrust LDAP Lookup

&7

& ht_vcenter_svc
& krbtgt
L PSC-NEFMO4VCSS

HyTrust VCenter svc account

Add

Users: |dem04\acs.loca [\ht_vcenter_sve |

Groups: | |

Separate multiple names with semicolons | Check names

[ ok || cancel |

5.2.10 Configure HTCC for AD authentication

HTCC requires a directory services solution. In this deployment solution, HTCC authentication will be set
up to work with Microsoft AD. Before you configure HTCC to use AD, you must define two groups and
one user. You can do this via existing AD entries or create entries just for HTCC (as is the case in our
implementation).

By default, HTCC is set to use a demo userid/password authentication. Once you change to AD
authentication, you cannot revert back to the demo authentication.

If AD is configured with TLS, the AD server’s certificate must be imported into HTCC. To configure HTCC
with an AD server with TLS configuration, refer to the HTCC Administration Guide for the following
steps:

1. Toimport AD Server certificate into HTCC, refer to the HTCC Administration Guide section titled
“Installing a Third-Party Root Certificate.”

2. Configure AD with TLS in HTCC. Refer to the HTCC Administration Guide section titled “Integrat-
ing the Appliance with Active Directory.”
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1423  To set up HTCC authentication, follow these steps:

1424 1. Logonto the HTCC web console, using URL https://<HTCC-Virtual-IP>/asc with the default
1425 username of superadminuser and the password Pas$w0rd123!
1426 2. From the HTCC dashboard, select the Configuration menu, and then Authentication.
1427 3. Change the Authentication Server Type to Directory Service and accept your changes.
1428 4. You should see a screen for configuring the service account. Make sure that the default domain
1429 name is the one you used to deploy the instance. In our demo, it’s demo3vcf.local. In the ser-
1430 vice account name field, enter the username (ht_ldap_svc) and password that you used during
1431 the AD setup steps.
1432 5. Click Next, and you will see the domain listed. Click Next again.
1433 6. You should now see the Role-Group Mapping page. Look under the ASC_SuperAdmin section
1434 entry. Confirm that your AD domain is listed in the selected pull-down entry. In the group name
1435 field, enter the admin group name, ht_superadmin_users, that you created earlier in the initial
1436 AD setup. HTCC will attempt to perform predictive searches to allow for name completion.
ASC_SecurityOperator demo3vcf -
ASC_StorageAdmin demo3vcf -
demodvef = ht_su
ASC_ThirdParty demoavef = ht_super_admins o
1437 7. Click Next and review the summary. If it is correct, finish. If AD is working correctly, the web in-
1438 terface will automatically log you out.
1439 8. Log back in using the Administrator user and password of your Windows AD/DNS Server (which
1440 is the domain controller). Recall that we had added Administrator to the ht_superadmin_users
1441 group in Windows AD.

1442 At this point, AD should be correctly set up for deployment. You are ready to set up the trust attestation
1443 service.

1444 5.3 Add Hosts to HTCC and Enable Good Known Host (GKH)

1445 You will add hosts in vCenter and then enable the Good Known Host (GKH) values to make them
1446  Trusted.
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1447 First, since all the hosts are managed by vCenter (as compared to standalone ESX hosts), you will add
1448 vCenter as the host—that will automatically detect the NSX server and the ESX hosts, and add them to
1449 HTCC. The high-level steps are:

1450 1. In HTCC, add vCenter as the host. For vCenter, use the same AD LDAP used for the HTCC vCenter
1451 AD id, ht_vcenter_svc@ibm.local (change the domain name based on what you have). While
1452 you can use Administrator@vsphere.local, best practice suggests you use the AD id.

1453 2. For all the ESX hosts that are detected, add their user ids/passwords and Publish IPs.

1454 3. If the vCenter and ESX host patch levels are not one of the valid patches supported by HTCC, add
1455 the patch level to HTCC so it recognizes them as valid hosts.

1456 Next, follow the directions at Enabling a Good Known Host, then Verifying and Updating Host Trust.

1457 Finally, to define, assign, and provision PolicyTags, follow these steps:

1458 1. Define PolicyTags in CloudControl.

1459 2. Assign PolicyTags to hosts. Important: We recommend that you put your host in maintenance
1460 mode before assigning PolicyTags, especially if you are modifying existing PolicyTag assignments
1461 which may be in use by your existing compliance rules. Do not remove the host from mainte-
1462 nance mode until you have verified that the new PolicyTag assignment has been correctly provi-
1463 sioned.

1464 a. Select Compliance > Hosts.

1465 b. On the Hosts page, check the checkbox for the Intel TXT-enabled host and click Edit.
1466 c. On the Edit Hosts page, select the PolicyTag tab.

1467 d. Select the appropriate PolicyTag value for one or more of the fields listed in Section 1.
1468 e. Click OK.

1469 f. CloudControl displays a JGrowl error message that prompts users to PXE boot the

1470 host(s) to activate the PolicyTag assignment.

1471 3. Follow all of the PolicyTags provisioning directions in Section 4.3.1.

1472 4. Verify the provisioning using these steps:

1473 a. Open CloudControl and select Compliance > Hosts.

1474 b. Select the host that you just updated and click Update Trust.

1475 c. Select Policy > Resources.

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud laaS Environments 49


https://docs.hytrust.com/CloudControl/5.6.0/Online/Content/HTCC_Admin_Guide/Host-Management/Enabling-Good-Known-Host.html
https://docs.hytrust.com/CloudControl/5.6.0/Online/Content/HTCC_Admin_Guide/Host-Management/Verify-and-Update-Host-Trust.html
https://docs.hytrust.com/CloudControl/5.6.0/Online/Content/HTCC_Admin_Guide/Access-Policies/Adding-PolicyTags.html?Highlight=policytags

1476
1477
1478

1479
1480

1481
1482

1483

1484
1485
1486
1487
1488
1489
1490

1491
1492
1493
1494

1495

1496
1497

1498

1499
1500
1501
1502
1503

1504
1505
1506

DRAFT

d. Verify that the PolicyTags have been provisioned. If the tag icon next to the host being
provisioned is blue, then the PolicyTags assigned to the host are provisioned. If the tag
icon is yellow, then the PolicyTags assigned to the host are not provisioned.

e. Note: If the provisioning process was not successful, you may have to clear the TPM
once again and repeat the process.

f.  After the PolicyTag provisioning is successful, you can remove the hosts from mainte-
nance mode.

Intel TXT provides hardware-based security technologies that address the increasing and evolving
security threats across physical and virtual infrastructures by complementing runtime protections. Intel
TXT increases protection by allowing greater control of the launch stack through a Measured Launch
Environment (MLE) and enabling isolation in the boot process. More specifically, it extends the Virtual
Machine Extensions (VMX) environment of Intel Virtualization Technology (Intel VT), permitting a
verifiably secure installation, launch, and use of a hypervisor or OS. These measured values in the boot
process are extended to and stored in a TPM on the server.

To enable Intel TXT and the necessary TPM in server BIOS, follow the steps in Section 5.2.3. The steps in
Section 5.2.4 can be followed to verify that that each Dell ESXi host has successfully enabled the TPM
and Intel TXT. The steps in Section 5.2.5 can be followed to verify that the Dell ESXi hosts’ TPM values
are successfully read by the vCenter Server.

This section covers the installation and configuration of the RSA products used to build the example
solution.

7.1 RSA SecurlD

RSA Authentication Manager is the authentication, administration, and database management
component of RSA SecurlD, which provides strong authentication of users accessing valuable network
resources. Refer to RSA Authentication Manager 8.4 VMware Virtual Appliance Getting Started for
installation instructions. Another source of information is Getting Started with RSA Authentication

Manager.

Figure 7-1 represents a common RSA Authentication Manager deployment with primary and replica
instances, web tiers, and a load balancer. An external firewall protects the primary and replica instances,
and another external firewall protects the DMZ.
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Figure 7-1: RSA Authentication Manager Deployment Architecture
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7.2 RSA NetWitness

To install and configure virtual hosts for RSA NetWitness Platform 11.4, follow the instructions in the
Virtual Host Installation Guide. Start by reading the “Basic Virtual Deployment” section, then reading
and following the steps in the “Install NetWitness Platform Virtual Host in Virtual Environment” section
(except you can skip Step 1b).

The rest of this section explains how to configure NetWitness for VMware log collection from an ESX
host.

7.2.1 Configure the VMware ESX/ESXi Event Source

This section describes how to create a least privilege User to extract logs from an ESX/ESXi host. You first
create a role, then you create the user, and finally, you assign the role to the user.

1. Create arole as follows:
a. Logonto the ESXi host using the vSphere Client, with administrative privileges.
b. Click on Administration > Roles.

c. Click on Add Role.
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d. Enter RSA Log Capture as the name of the Role.
e. Choose All Privileges > Global > Diagnostics as the only privilege for this role.
2. Create a local ESXi user as follows:

a. From the Left navigation pane, click on the ESXI host, then click the Users or Local Users
& Groups tab. The name of the tab depends on the credentials you used to log onto the
ESXi host.

b. Right-click on the Users tab, then click Add.
c. Enterrsa-vcenter-logs in the Login field, and choose a strong password.
3. Assign the role to the local user as follows:
a. From the Left navigation pane, click on the ESXI host, then click the Permissions tab.
b. Right-click in the Permissions table, then click Add Permission.
c. Inthe dialog box, under the Assigned Role drop-down menu, choose RSA Log Capture.

d. Under Users and Groups, click Add.... The Select Users and Groups dialog box is dis-
played.

e. Inthe dialog box, leave the Domain value as (server), and select the rsa-vcenter-logs
user.

f. Click Add, then click OK.

This completes the process of adding a least privilege user. When you configure the Log Collector for
VMware collection in RSA NetWitness Suite, make sure to enter the credentials for this user in the Add
Source dialog box.

7.2.2 Configure the RSA NetWitness Log Collector for VMware Collection

To configure the RSA NetWitness Log Collection for VMware Collection, go to page 105 in the Log
Collection Configuration Guide for RSA NetWitness Platform 11.4, and follow the instructions in the
section titled “Configure VMware Event Sources in NetWitness Platform.”

This section covers all the aspects of installing and configuring the VMware products used to build the
example solution.
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8.1 Prerequisites

The VMware Validated Design (VVD) is a blueprint for a Software Defined Data Center (SDDC). A
Standard deployment model was used. In order to prepare for the implementation of the VVD, review
the following documentation. It outlines the preparation and planning phases, contains logical design
architectures and design decisions related to the implementation, and assists with the end-to-end
process of deploying a VVD:

VMware Validated Design Documentation

Documentation Structure and Audience (VVD 4.3, VVD 5.0.1), see Figure 8-1

e Architecture and Design

e Planning and Preparation Deployment

e Planning and Preparation Upgrade

e Monitoring and Alerting

e Backup and Restore

e Site Protection and Recovery

e Certificate Replacement

e Operational Verification

e IT Automating IT

e Intelligent Operations

e Security and Compliance Configuration for NIST 800-53:
= Introduction to Security and Compliance

=  Product Applicability Guide for NIST 800-53

=  Configuration for Compliance with NIST 800-53
=  Audit Compliance with NIST 800-53
Introducing VMware Validated Design for Software-Defined Data Center (VVD 4.3, VVD 5.0.1)
Design Objectives of VMware Validated Designs (VVD 4.3, VVD 5.0.1)
Overview of Standard SDDC (VVD 4.3, VVD 5.0.1)
VMware Validated Design Architecture and Design (VVD 4.3, VVD 5.0.1)
VMware Validated Design Planning and Preparation (VVD 4.3, VVD 5.0.1)

VMware Validated Design for Software-Defined Data Center Release Notes (VVD 4.3, VVD 5.0,
VVD 5.0.1)
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To visualize how the VVD works in conjunction with the Compliance Kit for NIST 800-53, Figure 8-1
provides an overview of the documentation structure. The VMware Validated Design Compliance Kit
enhances the documentation of the VVD for SDDC and must be applied after the SDDC is deployed.

Figure 8-1: Map of VVD Documentation
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To reconfigure your SDDC for compliance with NIST SP 800-53 (https://doi.org/10.6028/NIST.SP.800-
53r4), you must download and license additional VMware and third-party software.

The VVD coupled with Security and Compliance Configuration for NIST 800-53 uses scripts and
commands based on VMware PowerCLI to reconfigure the SDDC. You must prepare a host with a
supported OS for running Microsoft PowerShell, set up Microsoft PowerShell, and install the latest
version of VMware PowerCLI. The host must have connectivity to the ESXi management network in the
management cluster.

8.2 Installation and Configuration

Review the following documentation for the complete guide concerning the installation and
configuration for the VVD for an SDDC for a Standard Deployment:

= Deployment for Region A (VVD 4.3, VVD 5.0.1)
= Deployment for Region B (VVD 4.3, VVD 5.0.1)

8.3 Configuration Customization Supporting the Use Cases and Security
Capabilities

After deployment of a Standard VVD, the enhancements outlined in this publication should be applied.
The security configurations and controls outlined in this section were implemented on a number of VVD
versions, beginning with VVD 4.2 and then VVD 4.3. In addition to this lab, a separate project to publish
the security configurations as a Compliance Kit that works as an enhancement to the VVD was published
to VVD version 5.0.1. Changes between VVD 4.2, 4.3, 5.0.1, and even the most current version as of this
writing, 5.1, are unlikely to have a significant impact to the configuration guidance.

Although this document outlines a specific version of the VVD, the Compliance Kit has been developed
to support VVD 4.3, 5.0.1, 5.1, and future VVD releases. This section discusses the VMware Validated
Design 5.0.1 Compliance Kit for NIST 800-53 and provides supplemental information detailing the
resources that are included within the kit because the kit was not formally published for VVD 4.2 or 4.3,
even though it was tested based on these versions. The VVD 5.0.1 Compliance Kit contains a number of
files, including:

= Introduction to Security and Compliance
= Product Applicability Guide

= Configuration Guide

= Audit Guide

= Audit Guide Appendix
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The configuration procedures included within the kit are in two groups:

=  Built-In Controls: Security controls based on compliance requirements are included in the VVD
for SDDC. These may require configuration and adjustment, but by design the capabilities are
included in the VVD for SDDC.

= Enhanced Controls: Additional guidance on a per regulation or standard basis includes a set of
capabilities that can be added to the VVD for SDDC.

Over time, we expect a significant number of enhancement VVD controls to be incorporated into the
VVD for SDDC. The enhancement guide always contains some number of NIST controls that are
applicable to NIST SP 800-53 but are not included in the VVD for SDDC implementation. Each procedure
documented in the Configuration Guide includes the NIST SP 800-53 control(s) that are associated with
each. Two examples sampled from the Configuration Guide are included in Sections 8.3.1 and 8.3.2.

Although the compliance kit was designed under VVD 5.0.1, the procedures and information included
within the following sections are applicable to future releases of VVD, including VVD 5.1 and 5.1.1.
Please note that while future iterations of the compliance kit will include configurations across all
products, version 5.0.1 only corresponds to the following products: vCenter, ESXi, NSX for vSphere (NSX-
V), and vSAN.

The following products are part of the VVD Bill of Materials, but not included in the current iteration of
the Compliance Kit: vRealize, vRealize Automation (vRA), vRealize Operations Manager (vVROPS), and
vRealize Log Insight (VRLI). The documentation surrounding the configuration of these products does
exist and is sourced from their respective DISA Security Technical Implementation Guides, which can be
reviewed at https://public.cyber.mil/stigs/downloads. There are two examples for these configurations
sampled from the Configuration Guide (Sections 8.3.3 and 8.3.4).

8.3.1 Example VVD 5.0.1 Configuration: Configure the Password and Policy
Lockout Setting in vCenter Server in Region A

1. Inaweb browser, log into vCenter by using the vSphere Web Client.
2. Configure the password policies.
a. From the Home menu of the vSphere Web Client, click Administration.
b. Inthe Navigator, under Single Sign-On, click Configuration.
c. Onthe Policies tab, under Password Policy, click Edit.
d. Inthe Edit Password Policies dialog box, configure the password policies and click OK.
i. Maximum Lifetime should be set to 60.

ii. Restrict Reuse should be set to 5.
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iii.  Minimum Length should be set to 15.
iv. Upper-case Characters should be set to 1.
v. Lower-case Characters should be set to 1.
vi. Numeric Characters should be set to 1.
vii. Special Characters should be set to 1.
3. Configure the lockout policies.
a. On the Policies tab, click Lockout Policy and click Edit.

b. In the Edit Lockout Policy dialog box, for Maximum Number of Failed Login Attempts,
enter 3.

c. For Interval Between Failures, enter 900.

d. For Unlock Time, enter 0 and then click OK.

8.3.2 Example VVD 5.0.1 Configuration: Configure Encryption Management in
Region A

1. Inaweb browser, login to vCenter Server by using the vSphere Web Client.
2. Enable Host Encryption Mode on the sfo01m01esx01.sfo01.rainpole.local host.
a. From the Home menu of the vSphere Web Client, select Hosts and Clusters.

b. Under the sfo01-m01dc data center, select the sfo01m01esx01.sfo01.rainpole.local
host and click the Configure tab.

c. Under System, click Security profile.
d. Under Host Encryption Mode, click Edit.

e. Inthe Set Encryption Mode dialog box, from the Encryption Mode drop-down menu,
select Enabled and click OK.

f. Repeat the procedure for all remaining hosts in Region A.
3. Enable VM encryption on all the VMs and virtual disks.
a. From the Home menu of the vSphere Web Client, select VMs and Templates.

b. Under the sfo01-m01dc data center, expand the sfo01-m01fd-bcdr folder, right-click
the sfo01mO01vc01 VM and select VM Policies, then Edit VM Storage Policies.
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c. From the VM Storage Policy drop-down menu, select VM Encryption Policy, click Apply
to all, and click OK.

d. Repeat the procedure to reconfigure the remaining VMs in Region A.

8.3.3 Example vRealize Automation DISA STIG Configuration: Configure SLES for
VRealize to protect the confidentiality and integrity of transmitted
information

1. Update the “Ciphers” directive with the following command:
sed -1 "/~ ["#]*Ciphers/ c\Ciphers aes256-ctr,aesl28-ctr" /etc/ssh/sshd config

2. Save and close the file.

3. Restart the sshd process:

service sshd restart

8.3.4 Example vRealize Operations Manager DISA STIG Configuration: Configure
the vRealize Operations server session timeout

1. Logon to the admin Ul as the administrator.

2. Navigate to Global Settings.

3. Select Edit Global Settings.

4. Set the Session Timeout setting to 15 minutes.

5. Select OK.

8.4 Operation, Monitoring, and Maintenance

This section explains how to operate, monitor, and maintain various VMware products. It points to
existing documentation whenever possible, so this document only includes supplemental information,
such as backup and recovery processes, and specific monitoring practices recommended for the
example solution.

8.4.1 Operation

This section discusses the basic operation of the VVD 5.0.1 for an SDDC, in addition to any relevant
products associated with such operations.

vSphere vCenter Server (vCS) Appliance is a management application that allows for the management of
VMs and ESXi hosts centrally. The vSphere Web Client is used to access the vCS.
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vRealize Operations Manager (VROPS) tracks and analyzes the operation of multiple data sources in the
SDDC by using specialized analytic algorithms. The algorithms help vROPS learn and predict the behavior
of every object that it monitors. Users access this information by views, reports, and dashboards.

vRealize Automation (VRA) provides a secure web portal where authorized administrators, developers,
and business owners can request new IT services and manage specific cloud and IT resources, while
ensuring compliance with business policies.

Please review the following for further information and discussion pertaining to the operational
standards of the VVD 5.0.1 for an SDDC: VMware Validated Design Documentation, VMware Validated
Design 5.0.1 Compliance Kit for NIST 800-53, and NIST SP 1800-198B.

8.4.2 Monitoring

This section outlines monitoring and alerting functionalities and best practices pertaining to VVD.

Use the vRealize Log Insight (VRLI) event signature engine to monitor key events and to send filtered or
tagged events to one or more remote destinations. You can use a set of alerts to send to vROPS and
through SMTP for operations team notification. The use of vRLI allows you to monitor the SDDC and
provide troubleshooting and cause analysis, which can reduce operating costs.

With the integration between vRLI and vROPS, you can implement the following cross-product event
tracking:

= Send alerts from vRLI to vVROPS, which maps them to the target objects.
= Launch in context from a VROPS object to the objects logs in vRLI.
= Launch in context from a vRLI event to the objects in vROPS.
Use applications in vVROPS to group monitoring data about the virtual machines of the SDDC

management components.

VROPS builds an application to determine how your environment is affected when one or more
components experience problems. You can also monitor the overall health and performance of the
application.

VROPS collects data from the components in the application and displays the results in a summary
dashboard with a real-time analysis for any or all the components.

Ensuring that your backup solution is configured to trigger an email alert generation showing the status
of your backup jobs is a recommended practice within the SDDC. This should be included in daily
monitoring activities to ensure that all management objects within the SDDC have successful backup
images. The following can be done to enable broad monitoring using vROPS:
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1. Create applications in vVROPS to group the monitoring data

a. about the VMs of vRealize Suite Lifecycle Manager

b. about the VMs of vRLI

c. about the VMs of VMware Site Recovery Manager

d. about the VMs of VMware vSphere Replication (VR)

e. for the VMs of vROPS

f. collected from your vSphere Storage APIs for Data Protection (VADP)-based backup so-
lution VMs

g. about the VMs of VMware vSphere Update Manager Download Service (UMDS)

2. Create email notifications in VROPS so it informs the SDDC operators of issues in the main moni-
toring parameters of the environment.

3. Configure vROPS to send email notifications about important alerts in the SDDC.

Please review the Monitoring and Alerting documentation for more information regarding the

monitoring of the VVD 4.3 deployment, and the VVD for SDDC 5.0.1 release notes for more information
on monitoring for VVD 5.0.1 deployments.

8.4.3 Maintenance

This section outlines the steps to perform an SDDC upgrade that follows a defined upgrade path. The
NCCoE project started with VVD version 4.3 and upgraded to 5.0.1. Table 8-1 provides a summary of the
system requirements and upgrade sequence associated with the Bill of Materials (BOM) or product
versions associated with each VVD version. This upgrade path is functional and defined by layers in
which the components are upgraded or updated. It is important to note that functional and scalability
tests for individual patches and express patches are not required for an environment.

Table 8-1: Summary of VVD Version and Associated Bill of Materials (Product Versions)

SDDC Layer

Product Name

Product Ver-
sion in VVD 4.3

Product Ver-
sion in VVD
5.0.1

Operation
Type

Operations Man- | vRealize Suite Lifecycle Manager 1.2 2.0.0 Patch2 | Upgrade
agement

vRealize Log Insight 4.6 4.7 Upgrade

vRealize Log Insight Agent 4.6 4.7 Upgrade

vRealize Operations Manager 6.7 7.0 Upgrade
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SDDC Layer

Product Name

Product Ver-
sion in VVD 4.3

Product Ver-
sion in VVD
5.0.1

Operation
Type

Cloud Manage- vRealize Business for Cloud 7.4 7.5 Upgrade
ment
vRealize Automation with Embed- | 7.4 7.5 Upgrade
ded vRealize Orchestrator
Business Conti- Site Recovery Manager 6.5.1.1 8.1.1 Upgrade
nuity
vSphere Replication 6.5.1.3 8.1.1 Upgrade
Backup solution based on VMware | Compatible Compatible Vendor
vSphere Storage APIs for Data Pro- | Version Version Specific
tection
Virtual Infrastruc- | NSX Data Center for vSphere 6.4.1 6.4.4 Update
ture
Platform Services Controller 6.5 Update 2 6.7 Update 1 Upgrade
vCenter Server 6.5 Update 2 6.7 Update 1 Upgrade
vSphere Update Manager Down- 6.5 Update 2 6.7 Update 1 Upgrade
load Service
ESXi 6.5 Update 2 6.7 Update 1 Upgrade
vSAN 6.6.1 Update2 | 6.7 Update 1 Upgrade

The following are tips for upgrading the SDDC:

= Before you begin any upgrade process, review all the release notes.

= Consider that the SDDC design and implementation may be affected by security features that
are enabled. Ensure interoperability testing is performed before and after making security
changes, as well as when introducing new features, functionality, and bug fixes.

= The environment within the NCCoE lab varies from the conventional VVD deployment because
for the NCCoE, additional integration with vendors is included, e.g., integration between HyTrust
components and Key Management Server (KMS) and the VVD.

= Note that if a distributed environment is used, ensure there is replication by using the
vdcrepadmin command line interface between the platform services controller (PSC) and the
vCenter environments. This can be checked by following the instructions in VMware Knowledge
Base article 2127057.
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= Perform a backup copy of your current certificates before you start the upgrade process. If you
need to request a new certificate, ensure you follow the procedures in this document for VVD
4.3 and this document for VVD 5.1.

The following is a tip for updating the SDDC:

= Ensure an operational verification test is performed before and after performing an update. In
most cases, updates should not impact the SDDC design and implementation (updates could
include patches and bug fixes).

Updates that are not validated by VVD should be approached with caution.

= Scalability and functionality tests for individual patches, express patches, and hot fixes are not
typically performed using the VVD. If a patch must be applied to your environment, follow the
VMware published practices and VMware Knowledge Base articles for the specific patch. If an
issue occurs during or after the process of applying a patch, contact VMware Technical Support.

=  For further information and instruction regarding an update, please see the documentation for
VVD 4.3 or VVD 5.0.

8.5 Product Configuration Overview

This section contains Table 8-2, which details all configurations for each product, their corresponding
enhanced or built-in label, and their mapped NIST SP 800-53 Revision 4 controls (which are defined at
https://doi.org/10.6028/NIST.SP.800-53r4). The labels are derived from the compliance kit with the
exception of the vRA and vROPS items, which are sourced directly from their corresponding DISA STIGs.

There are only a small number of vROPS and vRA DISA STIGs included in the following table, which
means it does not include all available configurations. For the entire compilation of vROPS and vRA DISA
STIGs, please review the following links:

= VMware vRealize Automation 7.x Lighttpd

= VMware vRealize Automation 7.x SLES

= VMware VRealize Automation 7.x tc Server

= VMware VRealize Operations Manager 6.x Application

= VMware vRealize Operations Manager 6.x SLES

= VMware vRealize Operations Manager 6.x tc Server

= VMware vRealize — Cassandra

There are a few notable items for which there are no NIST control mappings; rather, they are identified
as “VMware Best Practices”. These items are not sourced from any existing DISA STIGs, hardening
guides, or other compliance frameworks. Their implementation is strongly recommended.

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud laaS Environments 62


https://docs.vmware.com/en/VMware-Validated-Design/4.3/com.vmware.vvd.sddc-certificate.doc/GUID-ADE495EB-117C-4FDA-AC3A-A42FD3FE25E9.html
https://docs.vmware.com/en/VMware-Validated-Design/4.3/com.vmware.vvd.sddc-certificate.doc/GUID-ADE495EB-117C-4FDA-AC3A-A42FD3FE25E9.html
https://docs.vmware.com/en/VMware-Validated-Design/5.1/sddc-certificate-replacement/GUID-FA99EBD8-CE1C-405A-96C8-7B5EA9F79D23.html
https://docs.vmware.com/en/VMware-Validated-Design/4.3/vmware-validated-design-43-sddc-upgrade.pdf
https://docs.vmware.com/en/VMware-Validated-Design/5.0/com.vmware.vvd.sddc-upgrade.doc/GUID-D97D5696-89F3-4425-97A4-3CE799C79532.html
https://doi.org/10.6028/NIST.SP.800-53r4
https://www.stigviewer.com/stig/vmware_vrealize_automation_7.x_lighttpd/
https://www.stigviewer.com/stig/vmware_vrealize_automation_7.x_sles/
https://www.stigviewer.com/stig/vmware_vrealize_automation_7.x_tc_server/
https://www.stigviewer.com/stig/vmware_vrealize_operations_manager_6.x_application/
https://www.stigviewer.com/stig/vmware_vrealize_operations_manager_6.x_sles/
https://www.stigviewer.com/stig/vmware_vrealize_operations_manager_6.x_tc_server/
https://www.stigviewer.com/stig/vrealize_-_cassandra/

1794

DRAFT

Table 8-2: Configuration Items Without Control Mappings

Product
Name

Configuration Label

Enhanced
or Built-in

NIST SP 800-53 Rev. 4 Controls

ESXi NIST80053-VI-ESXI-CFG-00048 Enhanced | AC-12

ESXi NIST80053-VI-ESXI-CFG-00146 Built-In AC-14a, AC-14b

ESXi NIST80053-VI-ESXI-CFG-00031 Enhanced | AC-17

ESXi NIST80053-VI-ESXI-CFG-00165 Built-In AC-7

ESXi NIST80053-VI-ESXI-CFG-00002 Enhanced | AC-8

NSX NIST80053-VI-NET-CFG-00343 Built-In CM-7

NSX NIST80053-VI-NET-CFG-00344 Built-In CM-7

NSX NIST80053-VI-NET-CFG-00372 Enhanced | CP-9

NSX NIST80053-VI-NET-CFG-00374 Enhanced | CP-9

NSX NIST80053-VI-NET-CFG-00312 Built-In IA-5

vCenter | NIST80053-VI-VC-CFG-00453 Built-In VMware Best Practice only. No spe-
cific UCF_NIST_800 53 R4 High con-
trol is associated with this capability.

vCenter | NIST80053-VI-VC-CFG-00465 Built-In VMware Best Practice only. No spe-
cific UCF_NIST_800 53 R4 High con-
trol is associated with this capability.

vCenter | NIST80053-VI-VC-CFG-00442 Enhanced | AU-5(2)

vCenter | NIST80053-VI-VC-CFG-00461 Built-In AU-9, AU-6a, AU-2d, AC-6(9)

vCenter | NIST80053-VI-VC-CFG-00460 Built-In AU-9, AU-7b, AU-7a, AU-7(1), AU-6a,
AU-12c, AU-12a, AC-6(9)

vRA VRAU-TC-000710 Enhanced | AC-17 (1)

vRA VRAU-VA-000010 Enhanced | AC-17 (2)

VRA VRAU-HA-000140 Enhanced | CM-7a

VRA VRAU-LI-000215 Enhanced | CM-7a

vRA VRAU-SL-000360 Enhanced | IA-5 (1) (b)

VRA VRAU-VI-000240 Enhanced | IA-5 (1) (c)

VRA VRAU-AP-000265 Enhanced | IA-7

vRA VRAU-PG-000470 Enhanced | SC-13

vROPS VROM-CS-000005 Enhanced | AC-3

VROPS VROM-PG-000220 Enhanced | IA-7

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud laaS Environments 63




1795

DRAFT

Product Configuration Label Enhanced | NIST SP 800-53 Rev. 4 Controls

Name or Built-in

vROPS VROM-SL-001240 Enhanced | SC-13

vROPS VROM-TC-000505 Enhanced | SC-2

vSAN NIST80053-VI-Storage-SDS-CFG-00182 | Built-In AC-11a

vSAN NIST80053-VI-Storage-SDS-CFG-00186 | Enhanced | AU-4

vSAN NIST80053-VI-Storage-SDS-CFG-00180 | Built-In AU-8b, AU-8a, AU-8(1)(b), AU-8(1)(a)

vSAN NIST80053-VI-Storage-SDS-CFG-00181 | Built-In AU-9, AU-7b, AU-7a, AU-7(1), AU-63,
AU-12c, AU-12a, AC-6(9)

vSAN NIST80053-VI-Storage-SDS-CFG-00183 | Enhanced | SC-13, MP-5(4), AU-9(3)

vSphere | NIST80053-VI-VSPHERE-CFG-00571 Enhanced | CM-6

vSphere | NIST80053-VI-VSPHERE-CFG-00563 Enhanced | IA-2
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Appendix A  Security Configuration Settings

This appendix captures the security configuration settings (Common Configuration Enumerations [CCEs]). The following table lists the VMware
products and their associated security configurations.

CCE Configur  Built-In/ Prod- Audit Procedure Recommended
ID ation(s) Enhanced uct Parameter Value
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: aes128-ctr,aes192-
8440 | 53-VI- # grep -i ""Ciphers" /etc/ssh/sshd config ctr,aes256-
1-9 ESXi- If there is no output or the output is not “Ciphers aesl28-ctr,aesl92- ctr,aes128-
CFG- ctr,aes256-ctr,aesl28-cbc,aesl92-cbc, aes256-cbc” or a subset of this list, cbc,aes192-
00001 ciphers that are not FIPS-approved are in use, so this is a finding. cbe,aes256-cbe
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: 2
8440 | 53-VI- # grep -i ""Protocol" /etc/ssh/sshd config
2-7 ESXi- If there is no output or the output is not exactly “Protocol 27, thisis a finding.
CFG-
00002
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: yes
8440 | 53-VI- # grep -i "“IgnoreRhosts" /etc/ssh/sshd config
3-5 ESXi- If there is no output or the output is not exactly “ITgnoreRhosts yes”, thisis a finding.
CFG-
00003
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: no
8440 | 53-VI- # grep -i "“HostbasedAuthentication" /etc/ssh/sshd config
43 ESXi- If there is no output or the output is not exactly “HostbasedAuthentication no”, this
CFG- is a finding.
00004
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CCE Configur

Built-In/

Prod-

Audit Procedure

Recommended

ID ation(s) Enhanced uct Parameter Value
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: no
8440 | 53-VI- # grep -i ""“PermitRootLogin" /etc/ssh/sshd config
5-0 ESXi- If there is no output or the output is not exactly “PermitRootLogin no”, thisis a finding.
CFG-
00005
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: no
8440 | 53-VI- # grep -i "“PermitEmptyPasswords" /etc/ssh/sshd config
6-8 ESXi- If there is no output or the output is not exactly “PermitEmptyPasswords no”, thisisa
CFG- finding.
00006
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: no
8440 | 53-VI- # grep -i "“PermitUserEnvironment" /etc/ssh/sshd config
7-6 ESXi- If there is no output or the output is not exactly “PermitUserEnvironment no”,thisisa
CFG- finding.
00007
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: hmac-shal,hmac-
8440 | 53-VI- # grep -i ""MACs" /etc/ssh/sshd config sha2-256,hmac-
8-4 ESXi- If there is no output or the output is not exactly “MACs hmac-shal, hmac-sha2- sha2-512
CFG- 256, hmac-sha2-512”, this is a finding.
00008
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: no
8440 | 53-VI- # grep -i "~GSSAPIAuthentication" /etc/ssh/sshd config
9-2 ESXi- If there is no output or the output is not exactly “GSSAPTIAuthentication no”, thisisa
CFG- finding.
00009
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CCE Configur

Built-In/

Prod-

Audit Procedure

Recommended

ID ation(s) Enhanced uct Parameter Value
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: no
8441 | 53-VI- # grep -i "“KerberosAuthentication" /etc/ssh/sshd config
0-0 ESXi- If there is no output or the output is not exactly “KerberosAuthentication no”, thisis

CFG- a finding.

00010
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: yes
8441 | 53-VI- # grep -i "“StrictModes" /etc/ssh/sshd config
1-8 ESXi- If there is no output or the output is not exactly “StrictModes yes”, thisis a finding.

CFG-

00011
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: no
8441 | 53-VI- # grep -i "“Compression" /etc/ssh/sshd config
2-6 ESXi- If there is no output or the output is not exactly “Compression no”, thisis a finding.

CFG-

00012
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: no
8441 | 53-VI- # grep -i "“GatewayPorts" /etc/ssh/sshd config
34 ESXi- If there is no output or the output is not exactly “GatewayPorts no”, thisis a finding.

CFG-

00013
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: no
8441 | 53-VI- # grep -i "”X1llForwarding" /etc/ssh/sshd config
42 ESXi- If there is no output or the output is not exactly “X11Forwarding no”, thisis a finding.

CFG-

00014
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CCE Configur

Built-In/

Prod-

Audit Procedure

Recommended

ID ation(s) Enhanced uct Parameter Value
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: AcceptEnv
8441 | 53-VI- # grep -i "“AcceptEnv" /etc/ssh/sshd config
5-9 ESXi- If there is no output or the output is not exactly “AcceptEnv”, this is a finding.

CFG-

00015
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: no
8441 | 53-VI- # grep -i "“PermitTunnel" /etc/ssh/sshd config
6-7 ESXi- If there is no output or the output is not exactly “PermitTunnel no”, thisis a finding.

CFG-

00016
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: 3
8441 | 53-VI- # grep -i "~ClientAliveCountMax" /etc/ssh/sshd config
7-5 ESXi- If there is no output or the output is not exactly “ClientAliveCountMax 3”,thisisa

CFG- finding.

00017
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: 200
8441 | 53-VI- # grep -i "~ClientAliveInterval" /etc/ssh/sshd config
8-3 ESXi- If there is no output or the output is not exactly “ClientAliveInterval 200", thisisa

CFG- finding.

00018
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: 1
8441 | 53-VI- # grep -i ""MaxSessions" /etc/ssh/sshd config
9-1 ESXi- If there is no output or the output is not exactly “MaxSessions 1”7, thisis a finding.

CFG-

00019
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CCE Configur

Built-In/

Prod-

Audit Procedure

Recommended

ID ation(s) Enhanced uct Parameter Value
CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: aes128-ctr,aes192-
8442 | 53-VI- # grep -i "“Ciphers" /etc/ssh/sshd config ctr,aes256-
0-9 ESXi- If there is no output or the output is not exactly “Ciphers aesl28-ctr,aesl92- ctr,aes128-
CFG- ctr,aes256-ctr,aesl28-cbc,aesl92-cbc, aes256-cbc”, ciphers that are not cbc,aes192-cbc,
00020 FIPS-approved may be used, so this is a finding. aes256-cbc
CCE- | NIST800 | Enhanced | ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following similar=deny re-
8442 | 53-VI- command: try=3 min=disa-
1-7 ESXi- Get-VMHost | Get-AdvancedSetting -Name bled,disabled,disa-
CFG- Security.PasswordQualityControl bled,disabled,15
00022 If Security.PasswordQualityControl is not set to “similar=deny retry=3
min=disabled, disabled,disabled,disabled, 15", thisis a finding.
CCE- | NIST800 | Enhanced | ESXi From a PowerCLlI command prompt, while connected to the ESXi host run the following AllIPEnabled: False
8442 | 53-VI- command:
2-5 ESXi- Get-VMHost | Get-VMHostFirewallException | Where {$ .Name -eqg
CFG- '"SSH Server' -and $ .Enabled -eq S$true} | Select
00028 Name,Enabled, @ {N="AllIPEnabled";E={$ .ExtensionData.AllowedHosts
LA11IPY}}
If for an enabled service “Al11low connections from any IP address”isselected,
this is a finding.
CCE- | NIST800 | Enhanced | ESXi From a PowerCLlI command prompt, while connected to the ESXi host run the following 0
8442 | 53-VI- command:
3-3 ESXi- Get-VMHost | Get-AdvancedSetting -Name
CFG- UserVars.SuppressShellWarning
00030 If UserVars.SuppressShellWarning is not set to 0O, this is a finding.
CCE- | NIST800 | Enhanced | ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following lockdownNormal
8442 | 53-VI- command:
4-1 ESXi-
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CCE Configur

Built-In/

Prod-

Audit Procedure

Recommended

ID ation(s) Enhanced uct Parameter Value

CFG- Get-VMHost | Select

00031 Name, @ {N="Lockdown";E={$ .Extensiondata.Config.LockdownMode}}

If Lockdown Mode is disabled, this is a finding.
For environments that do not use vCenter server to manage ESXi, this is not applicable.

CCE- | NIST800 | Enhanced | ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following 3
8442 | 53-VI- command:
5-8 ESXi- Get-VMHost | Get-AdvancedSetting -Name

CFG- Security.AccountLockFailures

00034 If Security.AccountLockFailures is not set to 3, this is a finding.
CCE- | NIST800 | Enhanced | ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following 600
8442 | 53-VI- command:
6-6 ESXi- Get-VMHost | Get-AdvancedSetting -Name

CFG- UserVars.ESXiShellInteractiveTimeOut

00038 If UserVars.ESXiShelllnteractiveTimeOut is not set to 600, this is a finding.
CCE- | NIST800 | Enhanced | ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following 600
8442 | 53-VI- command:
7-4 ESXi- Get-VMHost | Get-AdvancedSetting -Name UserVars.ESXiShellTimeOut

CFG- If UserVars.ESXiShellTimeOut is not set to 600, this is a finding.

00039
CCE- | NIST800 | Enhanced | ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following 1
8442 | 53-VI- command:
8-2 ESXi- Get-VMHost | Get-AdvancedSetting -Name Net.BlockGuestBPDU

CFG- If Net.BlockGuestBPDU is not set to 1, this is a finding.

00043
CCE- | NIST800 | Enhanced | ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following TRUE
8442 | 53-VI- commands:
9-0 ESXi-
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CCE Configur

Built-In/

Prod-

Audit Procedure

Recommended

ID ation(s) Enhanced uct Parameter Value
CFG- Sesxcli = Get-EsxCli
00056 Sesxcli.system.coredump.network.get ()
If there is no active core dump partition or the network core dump collector is not configured
and enabled, this is a finding.
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following FALSE
8443 | 53-VI- command:
0-8 ESXi- Get-VMHostFirewallDefaultPolicy
CFG- If the Incoming or Outgoing policies are True, this is a finding.
00106
CCE- | NIST800 | Enhanced | ESXi Log in to the host and run the following command: File should not ex-
8443 | 53-VI- # 1s -la /etc/ssh/keys-root/authorized keys ist
1-6 ESXi- If the authorized_keys file exists, this is a finding.
CFG-
00107
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following FALSE
8443 | 53-VI- command:
2-4 ESXi- Get-VMHostSnmp | Select *
CFG- or
00108

From a console or ssh session run the following command:
esxcli system snmp get

If SNMP is not in use and is enabled, this is a finding.

If SNMP is enabled and “read only communities” issetto public, thisis a finding.

If SNMP is enabled and is not using v3 targets, this is a finding.

Note: SNMP v3 targets can only be viewed and configured from the esxc1i command.
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CCE- | NIST800 | Enhanced | ESXi Connect via SSH and run the following command: remember=5
8443 | 53-VI- # grep -i "“password" /etc/pam.d/passwd | grep sufficient
32 ESXi- If the remember setting is not set or is not “remember=5", this is a finding.

CFG-

00109
CCE- | NIST800 | Built-in ESXi Run the following command: sha512
8443 | 53-VI- # grep -i "“password" /etc/pam.d/passwd | grep sufficient
4-0 ESXi- If sha512 is not listed, this is a finding.

CFG-

00110
CCE- | NIST800 | Enhanced | ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following Policy: Off and
8443 | 53-VI- command: Running: False
5-7 ESXi- Get-VMHost | Get-VMHostService | Where {$_ .Label -eq "SSH"}

CFG- If the ESXi SSH service is running, this is a finding.

00111
CCE- | NIST800 | Enhanced | ESXi From a PowerCLlI command prompt, while connected to the ESXi host run the following Policy: Off and
8443 | 53-VI- command: Running: False
6-5 ESXi- Get-VMHost | Get-VMHostService | Where {$ .Label -eq "ESXi

CFG- Shell"}

00112 If the ESXi Shell service is running, this is a finding.
CCE- | NIST800 | Enhanced | ESXi From a PowerCLlI command prompt, while connected to the ESXi host run the following Policy: Off and
8443 | 53-VI- command: Running: False
7-3 ESXi- Get-VMHost | Get-VMHostService | Where {$ .Label -eq "SSH"}

CFG- If the ESXi SSH service is running, this is a finding.

00113
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CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following sfo0l.rainpole.lo-
8443 | 53-VI- command: cal
8-1 ESXi- Get-VMHost | Get-VMHostAuthentication
CFG- For systems that do not use Active Directory and have no local user accounts, other than root,
00114 dcui, and/or vpxuser, this is not applicable.
For systems that do not use Active Directory and do have local user accounts, other than root,
dcui, and/or vpxuser, this is a finding.
If Directory Services Type is not set to “Active Directory”, this is a finding.
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to vCenter run the following command: JoinADEnabled:
8443 | 53-VI- Get-VMHost | Select Name, °~ @{N="HostProfile";E={$ | Get- True, JoinDomain-
9-9 ESXi- VMHostProfile}}, ° Q@{N="JoinADEnabled";E={($_ | Get- Method: Fixed-
CFG- VmHostProfile) .ExtensionData.Config.ApplyProfile.Authentication. | CAMConfigOption
00115 ActiveDirectory.Enabled}}, °~ @{N="JoinDomainMethod";E={ (($ |
Get-
VMHostProfile) .ExtensionData.Config.ApplyProfile.Authentication.
ActiveDirectory | Select -ExpandProperty Policy | Where {$ .Id -
eq "JoinDomainMethodPolicy"}) .Policyoption.Id}}
Verify if "JoinADEnabled" is "True” then "JoinDomainMethod" should be
"FixedCAMConfigOption".
For systems that do not use Active Directory and have no local user accounts, other than root,
dcui, and/or vpxuser, this is not applicable.
For systems that do not use Active Directory and do have local user accounts, other than root,
dcui, and/or vpxuser, this is a finding.
If vSphere Authentication Proxy is not used to join hosts to an Active Directory domain, this is
a finding.
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CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following sfo0l.rainpole.lo-
8444 | 53-VI- command: cal
0-7 ESXi- Get-VMHost | Get-VMHostAuthentication
CFG- For systems that do not use Active Directory and have no local user accounts, other than root,
00116 dcui, and/or vpxuser, this is not applicable.
For systems that do not use Active Directory and do have local user accounts, other than root,
dcui, and/or vpxuser, this is a finding.
If the Directory Services Type is not set to “Active Directory”, this is a finding.
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to vCenter run the following command: sfoO1l.rainpole.lo-
8444 | 53-VI- Get-VMHost | Select Name, °~ @{N="HostProfile";E={$ | Get- cal
1-5 ESXi- VMHostProfile}}, ° @{N="JoinADEnabled";E={(S$_ | Get-
CFG- VmHostProfile) .ExtensionData.Config.ApplyProfile.Authentication.
00117 ActiveDirectory.Enabled}}, °~ @{N="JoinDomainMethod";E={ (($ |

Get-

VMHostProfile) .ExtensionData.Config.ApplyProfile.Authentication.
ActiveDirectory | Select -ExpandProperty Policy | Where {$ .Id -
eq "JoinDomainMethodPolicy"}) .Policyoption.Id}}

Verify if "JoinADEnabled" is "True” then "JoinDomainMethod" should be
"FixedCAMConfigOption".

For systems that do not use Active Directory and have no local user accounts, other than root,
dcui, and/or vpxuser, this is not applicable.

For systems that do not use Active Directory and do have local user accounts, other than root,
dcui, and/or vpxuser, this is a finding.

If vSphere Authentication Proxy is not used to join hosts to an Active Directory domain, this is
a finding.
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CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following sfo0l.rainpole.lo-
8444 | 53-VI- command: cal
2-3 ESXi- Get-VMHost | Get-VMHostAuthentication
CFG- For systems that do not use Active Directory and have no local user accounts, other than root,
00118 dcui, and/or vpxuser, this is not applicable.
For systems that do not use Active Directory and do have local user accounts, other than root,
dcui, and/or vpxuser, this is a finding.
If Directory Services Type is not set to “Active Directory”, this is a finding.
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to vCenter run the following command: sfoO1.rainpole.lo-
8444 | 53-VI- Get-VMHost | Select Name, °~ @{N="HostProfile";E={$ | Get- cal
3-1 ESXi- VMHostProfile}}, °~ @{N="JoinADEnabled";E={($_ | Get-
CFG- VmHostProfile) .ExtensionData.Config.ApplyProfile.Authentication.
00119 ActiveDirectory.Enabled}}, °~ @{N="JoinDomainMethod";E={(($ |

Get-

VMHostProfile) .ExtensionData.Config.ApplyProfile.Authentication.
ActiveDirectory | Select -ExpandProperty Policy | Where {$ .Id -
eq "JoinDomainMethodPolicy"}) .Policyoption.Id}}

Verify if "JoinADEnabled" is "True” then "JoinDomainMethod" should be
"FixedCAMConfigOption".

For systems that do not use Active Directory and have no local user accounts, other than root,
dcui, and/or vpxuser, this is not applicable.

For systems that do not use Active Directory and do have local user accounts, other than root,
dcui, and/or vpxuser, this is a finding.

If vSphere Authentication Proxy is not used to join hosts to an Active Directory domain, this is
a finding.
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CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following sfo0l.rainpole.lo-
8444 | 53-VI- command: cal
4-9 ESXi- Get-VMHost | Get-VMHostAuthentication
CFG- For systems that do not use Active Directory and have no local user accounts, other than root,
00120 dcui, and/or vpxuser, this is not applicable.
For systems that do not use Active Directory and do have local user accounts, other than root,
dcui, and/or vpxuser, this is a finding.
If Directory Services Type is not set to “Active Directory”, this is a finding.
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to vCenter run the following command: sfoO1.rainpole.lo-
8444 | 53-VI- Get-VMHost | Select Name, °~ @{N="HostProfile";E={$ | Get- cal
5-6 ESXi- VMHostProfile}}, °~ @{N="JoinADEnabled";E={($_ | Get-
CFG- VmHostProfile) .ExtensionData.Config.ApplyProfile.Authentication.
00121 ActiveDirectory.Enabled}}, ° @{N="JoinDomainMethod";E={(($ |

Get-

VMHostProfile) .ExtensionData.Config.ApplyProfile.Authentication.
ActiveDirectory | Select -ExpandProperty Policy | Where {$ .Id -
eq "JoinDomainMethodPolicy"}) .Policyoption.Id}}

Verify if "JoinADEnabled" is "True” then "JoinDomainMethod" should be
"FixedCAMConfigOption".

For systems that do not use Active Directory and have no local user accounts, other than root,
dcui, and/or vpxuser, this is not applicable.

For systems that do not use Active Directory and do have local user accounts, other than root,
dcui, and/or vpxuser, this is a finding.

If vSphere Authentication Proxy is not used to join hosts to an Active Directory domain, this is
a finding.
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NIST800
53-VI-
6-4 ESXi-
CFG-
00122

Enhanced

ESXi

From a PowerCLI command prompt, while connected to the ESXi host run the following
command:

Get-VMHost | Get-AdvancedSetting -Name
Annotations.WelcomeMessage

Check for the login banner text (mentioned in the parameter value) based on the character
limitations imposed by the system. An exact match of the text is required. If this banner is not
displayed, this is a finding.

This system is for
the use of author-
ized users only. In-
dividuals using this
computer system
without authority
or in excess of
their authority are
subject to having
all their activities
on this system
monitored and rec-
orded by system
personnel. Anyone
using this system
expressly consents
to such monitoring
and is advised that
if such monitoring
reveals possible ev-
idence of criminal
activity system
personal may pro-
vide the evidence
of such monitoring
to law enforce-
ment officials.
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CCE- | NIST800
53-VI-
7-2 ESXi-
CFG-
00123

Enhanced

ESXi

From a PowerCLI command prompt, while connected to the ESXi host run the following
command:

Get-VMHost | Get-AdvancedSetting -Name Config.Etc.issue

If the Config.Etc.issue setting (/etc/issue file) does not contain the logon banner exactly as
shown in the parameter value, this is a finding.

This system is for
the use of author-
ized users only. In-
dividuals using this
computer system
without authority
or in excess of
their authority are
subject to having
all their activities
on this system
monitored and rec-
orded by system
personnel. Anyone
using this system
expressly consents
to such monitoring
and is advised that
if such monitoring
reveals possible ev-
idence of criminal
activity system
personal may pro-
vide the evidence
of such monitoring
to law enforce-
ment officials.
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8-0
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NIST800
53-VI-
ESXi-
CFG-
00124

Built-In/

Prod-

Enhanced uct

Enhanced

ESXi

Audit Procedure

Connect via SSH and run the following command:
# grep -i "“Banner" /etc/ssh/sshd config

If there is no output or the output is not exactly “Banner /etc/issue”, thisis a finding.

Recommended
Parameter Value

This system is for
the use of author-
ized users only. In-
dividuals using this
computer system
without authority
or in excess of
their authority are
subject to having
all their activities
on this system
monitored and rec-
orded by system
personnel. Anyone
using this system
expressly consents
to such monitoring
and is advised that
if such monitoring
reveals possible ev-
idence of criminal
activity system
personal may pro-
vide the evidence
of such monitoring
to law enforce-
ment officials.
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CCE- | NIST800 | Enhanced | ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following script: | Remove unneces-
8444 | 53-VI- Svmhost = Get-VMHost | Get-View sary users from the
9-8 ESXi- $lockdown = Get-View S$vmhost.ConfigManager.HostAccessManager exception user list
CFG- Slockdown.QueryLockdownExceptions ()
00125 If the exception users list contains accounts that do not require special permissions, this is a
finding.
Note: This list is not intended for system administrator accounts but for special circumstances
such as a service account.
CCE- | NIST800 | Enhanced | ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following This system is for
8445 | 53-VI- command: the use of author-
0-6 ESXi- Get-VMHost | Get-AdvancedSetting -Name Annotations.WelcomeMessage ized users only. In-
CFG- Check for the login banner text (mentioned in the parameter value) based on the character dividuals using this
00127 computer system

limitations imposed by the system. An exact match of the text is required. If this banner is not
displayed, this is a finding.

without authority
or in excess of
their authority are
subject to having
all their activities
on this system
monitored and rec-
orded by system
personnel. Anyone
using this system
expressly consents
to such monitoring
and is advised that
if such monitoring
reveals possible ev-
idence of criminal
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activity system
personal may pro-
vide the evidence
of such monitoring
to law enforce-
ment officials.

CCE- | NIST800 | Enhanced | ESXi If vCenter Update Manager is used on the network, it can scan all hosts for missing patches. Apply latest

8445 | 53-VI- From the vSphere Client, go to Hosts and Clusters >> Update Manager tab, and select Scan to | patches and up-

1-4 ESXi- view all hosts’ compliance status. dates

CFG- If vCenter Update Manager is not used, a host’s compliance status must be manually

00129 determined by the build number. VMware KB 1014508 can be used to correlate patches with
build numbers.
If the ESXi host does not have the latest patches, this is a finding.
If the ESXi host is not on a supported release, this is a finding.

CCE- | NIST800 | Enhanced | ESXi The downloaded ISO, offline bundle, or patch hash must be verified against the vendor's Compare the SHA1

8445 | 53-VI- checksum to ensure the integrity and authenticity of the files. See the typical command line sum output with

2-2 ESXi- example for the shal hash check: the value posted

CFG- # shalsum <filename>.iso on the VMware
00134 If any of the system’s downloaded ISO, offline bundle, or system patch hashes cannot be Web site. SHA1
verified against the vendor’s checksum, this is a finding. hash should match.

CCE- NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following udp://sfo01vrli0l.s

8445 | 53-VI- command: foO1l.rainpole.lo-

3-0 ESXi- Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost cal:514

CFG- If Syslog.global.logHost is not set to a site-specific syslog server, this is a finding.
00135
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CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following [1 /scratch/log
8445 | 53-VI- command:
4-8 ESXi- Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logDir
CFG- If LocalLogOutputlsPersistent is not set to true, this is a finding.
00136
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following ug-SDDC-Admins
8445 | 53-VI- command:
5-5 ESXi- Get-VMHost | Get-AdvancedSetting -Name
CFG- Config.HostAgent.plugins.hostsvc.esxAdminsGroup
00137 For systems that do not use Active Directory and have no local user accounts, other than root,
dcui, and/or vpxuser, this is not applicable.
For systems that do not use Active Directory and do have local user accounts, other than root,
dcui, and/or vpxuser, this is a finding.
If Config.HostAgent.plugins.hostsvc.esxAdminsGroup is set to “ESX Admins”, this is a finding.
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following 2
8445 | 53-VI- command:
6-3 ESXi- Get-VMHost | Get-AdvancedSetting -Name Mem.ShareForceSalting
CFG- If Mem.ShareForceSalting is not set to 2, this is a finding.
00138
CCE- | NIST800 | Built-in ESXi From a PowerCLlI command prompt, while connected to the ESXi host run the following N/A
8445 | 53-VI- command:
7-1 ESXi- Get-VMHostFirewallDefaultPolicy
CFG- If the Incoming or Outgoing policies are True, this is a finding.
00139
CCE- | NIST800 | Built-in ESXi From a PowerCLlI command prompt, while connected to the ESXi host run the following udp://sfo01vrli0l.s
8445 | 53-VI- command: foOl.rainpole.lo-
8-9 ESXi- Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost cal:514
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CFG- If Syslog.global.logHost is not set to a site-specific syslog server, this is a finding.
00141
CCE- | NIST800 | Enhanced | ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following ug-SDDC-Admins
8445 | 53-VI- command:
9-7 ESXi- Get-VMHost | Get-AdvancedSetting -Name
CFG- Config.HostAgent.plugins.hostsvc.esxAdminsGroup
00142 For systems that do not use Active Directory and have no local user accounts, other than root,
dcui, and/or vpxuser, this is not applicable.
For systems that do not use Active Directory and do have local user accounts, other than root,
dcui, and/or vpxuser, this is a finding.
If Config.HostAgent.plugins.hostsvc.esxAdminsGroup is set to “ESX Admins”, this is a finding.
CCE- NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following udp://sfo01vrli0l.s
8446 | 53-VI- command: foOl.rainpole.lo-
0-5 ESXi- Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost cal:514
CFG- If Syslog.global.logHost is not set to a site-specific syslog server, this is a finding.
00143
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following ntp.lax01.rain-
8446 | 53-VI- command: pole.local,
1-3 ESXi- Get-VMHost | Get-VMHostNTPServer ntp.sfo01.rain-
CFG- Get-VMHost | Get-VMHostService | Where {$ .Label -eg "NTP Daemon"} pole.local
00145 If the NTP service is not configured with authoritative DoD time sources and the service is not
configured to start and stop with the host and is running, this is a finding.
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following PartnerSupported
8446 | 53-VI- commands:
2-1 ESXi- Sesxcli = Get-EsxCli
CFG- Sesxcli.software.acceptance.get ()
00157 If the acceptance level is CommunitySupported, this is a finding.
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CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following PartnerSupported
8446 | 53-VI- commands:
3-9 ESXi- Sesxcli = Get-EsxCli
CFG- Sesxcli.software.acceptance.get ()
00158 If the acceptance level is CommunitySupported, this is a finding.
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following PartnerSupported
8446 | 53-VI- commands:
4-7 ESXi- Sesxcli = Get-EsxCli
CFG- Sesxcli.software.acceptance.get ()
00159 If the acceptance level is CommunitySupported, this is a finding.
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following PartnerSupported
8446 | 53-VI- commands:
5-4 ESXi- Sesxcli = Get-EsxCli
CFG- Sesxcli.software.acceptance.get ()
00160 If the acceptance level is CommunitySupported, this is a finding.
CCE- | NIST800 | Built-in ESXi From a PowerCLlI command prompt, while connected to the ESXi host run the following FALSE
8446 | 53-VI- commands:
6-2 ESXi- Get-VDSwitch | Get-VDSecurityPolicy
CFG- Get-VDPortGroup | Get-VDSecurityPolicy
00161 If Forged Transmits is set to accept, this is a finding.
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following FALSE
8446 | 53-VI- commands:
7-0 ESXi- Get-VDSwitch | Get-VDSecurityPolicy
CFG- Get-VDPortGroup | Get-VDSecurityPolicy
00162 If MAC Address Changes is set to accept, this is a finding.
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CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following root
8446 | 53-VI- command:
8-8 ESXi- Get-VMHost | Get-AdvancedSetting -Name DCUI.Access
CFG- If DCUI.Access is not restricted to root, this is a finding.
00163 Note: This list is only for local user accounts and should only contain the root user.
CCE- NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following udp://sfo01vrli0l.s
8446 | 53-VI- command: foO1l.rainpole.lo-
9-6 ESXi- Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost cal:514
CFG- If Syslog.global.logHost is not set to a site-specific syslog server, this is a finding.
00164
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following 900
8447 | 53-VI- command:
0-4 ESXi- Get-VMHost | Get-AdvancedSetting -Name Security.AccountUnlockTime
CFG- If Security.AccountUnlockTime is not set to 900, this is a finding.
00165
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following FALSE
8447 | 53-VI- command:
1-2 ESXi- Get-VMHost | Get-AdvancedSetting -Name
CFG- Config.HostAgent.plugins.solo.enableMob
00166 If Config.HostAgent.plugins.solo.enableMob is not set to false, this is a finding.
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following ug-SDDC-Admins
8447 | 53-VI- command:
2-0 ESXi- Get-VMHost | Get-AdvancedSetting -Name
CFG- Config.HostAgent.plugins.hostsvc.esxAdminsGroup
00167 For systems that do not use Active Directory and have no local user accounts, other than root,

dcui, and/or vpxuser, this is not applicable.
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For systems that do not use Active Directory and do have local user accounts, other than root,
dcui, and/or vpxuser, this is a finding.
If Config.HostAgent.plugins.hostsvc.esxAdminsGroup is set to “ESX Admins”, this is a finding.
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following 600
8447 | 53-VI- command:
3-8 ESXi- Get-VMHost | Get-AdvancedSetting —-Name UserVars.DcuiTimeOut
CFG- If UserVars.DcuiTimeOut is not set to 600, this is a finding.
00168
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following "
8447 | 53-VI- command:
4-6 ESXi- Get-VMHost | Get-AdvancedSetting -Name Net.DVFilterBindIpAddress
CFG- If Net.DVFilterBindlpAddress is not blank and security appliances are not in use on the host,
00169 this is a finding.
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following udp://sfo01vrli0l.s
8447 | 53-VI- command: foO1l.rainpole.lo-
5-3 ESXi- Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost cal:514
CFG- If Syslog.global.logHost is not set to a site-specific syslog server, this is a finding.
00170
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following 600
8447 | 53-VI- command:
6-1 ESXi- Get-VMHost | Get-AdvancedSetting -Name UserVars.DcuiTimeOut
CFG- If UserVars.DcuiTimeOut is not set to 600, this is a finding.
00171
CCE- NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following udp://sfo01vrli0l.s
8447 | 53-VI- command: foO1l.rainpole.lo-
7-9 ESXi- Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost cal:514
If Syslog.global.logHost is not set to a site-specific syslog server, this is a finding.
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CFG-
00172
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following ug-SDDC-Admins
8447 | 53-VI- command:
8-7 ESXi- Get-VMHost | Get-AdvancedSetting -Name
CFG- Config.HostAgent.plugins.hostsvc.esxAdminsGroup
00173 For systems that do not use Active Directory and have no local user accounts, other than root,
dcui, and/or vpxuser, this is not applicable.
For systems that do not use Active Directory and do have local user accounts, other than root,
dcui, and/or vpxuser, this is a finding.
If the Config.HostAgent.plugins.hostsvc.esxAdminsGroup keyword is set to “ESX Admins”, this
is a finding.
CCE- NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following udp://sfo01vrli0l.s
8447 | 53-VI- command: foO1l.rainpole.lo-
9-5 ESXi- Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost cal:514
CFG- If Syslog.global.logHost is not set to a site-specific syslog server, this is a finding.
00174
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following ug-SDDC-Admins
8448 | 53-VI- command:
0-3 ESXi- Get-VMHost | Get-AdvancedSetting -Name
CFG- Config.HostAgent.plugins.hostsvc.esxAdminsGroup
00175 For systems that do not use Active Directory and have no local user accounts, other than root,

dcui, and/or vpxuser, this is not applicable.

For systems that do not use Active Directory and do have local user accounts, other than root,
dcui, and/or vpxuser, this is a finding.

If Config.HostAgent.plugins.hostsvc.esxAdminsGroup is set to “ESX Admins”, this is a finding.
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CCE- NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following udp://sfo01vrli0l.s
8448 | 53-VI- command: foO1.rainpole.lo-
1-1 ESXi- Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost cal:514
CFG- If Syslog.global.logHost is not set to a site-specific syslog server, this is a finding.
00176
CCE- | NIST800 | Built-in ESXi The vMotion VMkernel port group should be in a dedicated VLAN that can be on a common vMotion VMKernel
8448 | 53-VI- standard or distributed virtual switch as long as the vMotion VLAN is not shared by any other Port group should
2-9 ESXi- function and it is not routed to anything but ESXi hosts. The check for this will be unique per be in a dedicated
CFG- environment. VLAN. The check
00177 From the vSphere Client, select the ESXi host and go to Configure > Networking > VMKernel for this will be
adapters. Review the VLANs associated with the vMotion VMkernel(s) and verify they are unique per envi-
dedicated for that purpose and logically separated from other functions. ronment.
If long distance or cross vCenter vMotion is used, the vMotion network can be routable but
must be accessible to only the intended ESXi hosts.
If the vMotion port group is not on an isolated VLAN and/or is routable to systems other than
ESXi hosts, this is a finding.
For environments that do not use vCenter Server to manage ESXi, this is not applicable.
CCE- | NIST800 | Built-in ESXi The Management VMkernel port group should be in a dedicated VLAN that can be on a Management
8448 | 53-VI- common standard or distributed virtual switch as long as the Management VLAN is not shared | VMKernel Port
3-7 ESXi- by any other function and it is not routed to anything other than management related group should be in
CFG- functions such as vCenter. The check for this will be unique per environment. a dedicated VLAN.
00178 From the vSphere Client, select the ESXi host and go to Configure > Networking > VMKernel | The check for this
adapters. Review the VLANSs associated with the Management VMkernel and verify they are will be unique per
dedicated for that purpose and logically separated from other functions. environment
If the network segment is routed, except to networks where other management-related
entities are located such as vCenter, this is a finding.
If production virtual machine traffic is routed to this network, this is a finding.
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CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following info
8448 | 53-VI- command:
4-5 ESXi- Get-VMHost | Get-AdvancedSetting -Name Config.HostAgent.log.level
CFG- If Config.HostAgent.log.level is not set to info, this is a finding.
00179 Note: Verbose logging level is acceptable for troubleshooting purposes.
CCE- | NIST800 | Built-in ESXi From a PowerCLI command prompt, while connected to the ESXi host run the following info
8448 | 53-VI- command:
5-2 ESXi- Get-VMHost | Get-AdvancedSetting -Name Config.HostAgent.log.level
CFG- If Config.HostAgent.log.level is not set to info, this is a finding.
00180 Note: Verbose logging level is acceptable for troubleshooting purposes.
CCE- | NIST800 | Built-in ESXi From the vSphere Client, select the ESXi Host and go to Configure >> Networking >> N/A
8448 | 53-VI- VMKernel adapters. Review each VMkernel adapter that is defined and ensure it is enabled
6-0 ESXi- for only one type of management traffic.
CFG- If any VMkernel is used for more than one type of management traffic, this is a finding.
00181
CCE- | NIST800 | Built-in ESXi From the vSphere Client, select the ESXi Host and go to Configure >> Networking >> TCP/IP N/A
8448 | 53-VI- Configuration. Review the default system TCP/IP stacks and verify they are configured with
7-8 ESXi- the appropriate IP address information.
CFG- If any system TCP/IP stack is configured and not in use by a VMkernel adapter, this is a finding.
00182
CCE- | NIST800 | Built-in ESXi From a PowerCLlI command prompt, while connected to the ESXi host run the following Policy :On and
8448 | 53-VI- command: Running: True
8-6 ESXi- Get-VMHost | Get-VMHostNTPServer
CFG- Get-VMHost | Get-VMHostService | Where {$ .Label -eg "NTP Daemon"}
00192 If the NTP service is not configured with authoritative DoD time sources and the service is not

configured to start and stop with the host and is running, this is a finding.
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CCE- | NIST800 | Built-in ESXi This check refers to an entity outside the physical scope of the ESXi server system. The N/A
8448 | 53-VI- configuration of upstream physical switches must be documented to ensure that spanning
9-4 ESXi- tree protocol is disabled and/or portfast is configured for all physical ports connected to ESXi
CFG- hosts. Inspect the documentation and verify that the documentation is updated on a regular
00184 basis and/or whenever modifications are made to either ESXi hosts or the upstream physical
switches. Alternatively, log in to the physical switch and verify that spanning tree protocol is
disabled and/or portfast is configured for all physical ports connected to ESXi hosts.
If the physical switch's spanning tree protocol is not disabled or portfast is not configured for
all physical ports connected to ESXi hosts, this is a finding.
CCE- | NIST800 | Built-in NSX From the vSphere Web Client, go to Administration >> Single Sign-On >> Policies >> Password | NSX Manager Ap-
8450 | 53-VI- Policy. pliance - NSX Do-
1-6 NET- main Service Ac-
CFG- count - Password
00251 (Dependent on
Customer Configu-
rations)
CCE- | NIST800 | Built-in NSX From the vSphere Web Client, go to Administration >> Single Sign-On >> Policies >> Password | Border Gateway
8450 | 53-VI- Policy. Protocol Password
2-4 NET- (Dependent on
CFG- Customer Configu-
00252 rations)
CCE- | NIST800 | Built-in NSX From the vSphere Web Client, go to Administration >> Single Sign-On >> Policies >> Password | Universal Distrib-
8450 | 53-VI- Policy. uted Logical Router
3-2 NET- Password (Depend-
CFG- ent on Customer
00253 Configurations)
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CCE- | NIST800 | Built-in NSX Log on to NSX Manager Virtual Appliance, then go to Backup & Restore. Audit logs and Sys-
8450 | 53-VI- If “Audit Logs” or “System Events” are excluded (by default they are NOT excluded), this is a tem events are not
4-0 NET- finding. excluded

CFG-

00281
CCE- | NIST800 | Built-in NSX Log on to NSX Manager Virtual Appliance, then go to Manage Appliance Settings and look IPv6 should be dis-
8450 | 53-VI- under General Network Settings. abled
5-7 NET- If IPv6 is configured, this is a finding.

CFG-

00282
CCE- | NIST800 | Built-in NSX Log on to NSX Manager Virtual Appliance, then go to Manage Appliance Settings and look IPv6 DNS should be
8450 | 53-VI- under DNS Servers. disabled
6-5 NET- If IPv6 DNS is configured, this is a finding.

CFG-

00283
CCE- | NIST800 | Built-in NSX Log on to NSX Manager Virtual Appliance, then go to Manage Appliance Settings and look 1) Use at least
8450 | 53-VI- under Time Settings. three NTP servers
7-3 NET- If any the NTP Servers are not authorized or trusted, this is a finding. from outside time

CFG- sources

00285 -OR-

2) Configure a few
local NTP servers
on a trusted net-
work that in turn
obtain their time
from at least three
outside time
sources
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CCE- | NIST800 | Built-in NSX Log on to NSX Manager Virtual Appliance and go to Manage Appliance Settings. Verify syslog Remote syslog
8450 | 53-VI- server configuration. server is config-
8-1 NET- ured.
CFG-
00286
CCE- | NIST800 | Built-in NSX Log on to NSX Manager Virtual Appliance, then go to Manage Appliance Settings --> SSL 1) Appropriate Is-
8450 | 53-VI- Certificates. Click on the certificate and verify certificate details. suer
9-9 NET- 2) Correct certifi-
CFG- cate Type
00287 3) RSA Algorithm
4) 2048 bits keys or
higher
CCE- | NIST800 | Built-in NSX Assess the deployment and try to reach NSX manager being on standard network. The NSX No read or write
8451 | 53-VI- manager should only be reachable using isolation mechanisms. permissions on
0-7 NET- backup directory
CFG-
00288
CCE- | NIST800 | Built-in NSX Log in to the VMware vSphere environment and inspect which users have access permissions Procedural
8451 | 53-VI- to NSX Manager Virtual Appliance.
1-5 NET- If any user other than the intended administrator has access or is able to carry out any
CFG- administrative actions, this is a finding.
00289
CCE- | NIST800 | Built-in NSX Log in to the SFTP server and navigate to backup directory. No read or write
8451 | 53-VI- If the backup directory can be read or written to by users other than the backup user, thisisa | Permissions on
2-3 NET- finding. backup directory
CFG-
00290
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CCE- | NIST800 | Built-in NSX Log on to NSX Manager Virtual Appliance, then go to Manage Appliance Settings and look IPv4 DNS is author-
8451 | 53-VI- under General network settings. ized and secure
31 NET- If IPv4 DNS is not authorized or secure, this is a finding.
CFG-
00291
CCE- | NIST800 | Built-in NSX Log on to NSX Manager Virtual Appliance, then look under Backup & Restore. Verify “FTP FTP Server settings
8451 | 53-VI- Server settings”. (Dependent on
4-9 NET- Customer Configu-
CFG- rations)
00294
CCE- | NIST800 | Built-in NSX After downloading the media, use the MD5/SHA1 sum value to verify the integrity of the SHA1 or MD5 hash
8451 | 53-VI- download. Compare the MD5/SHA1 hash output with the value posted on the VMware secure | should match
5-6 NET- website.
CFG- If the hash output does not match the website value, this is a finding.
00295
CCE- | NIST800 | Built-in NSX If the controller network is not deployed on a network that is not configured for or connected | Procedural (De-
8451 | 53-VI- to other types of traffic, this is a finding. pendent on Cus-
6-4 NET- tomer Configura-
CFG- tions)
00296
CCE- | NIST800 | Built-in NSX Run this Rest API call to get the properties of the controller node: <ipSecEna-
8451 | 53-VI- https://<nsxmgr>/api/2.0/vdn/controller/node bled>true</ip-
7-2 NET- Response: SecEnabled >
CFG- <controllerNodeConfig>
00297 <ipSecEnabled>true</ipSecEnabled >

</controllerNodeConfig>
If ipSecEnabled is not true, this is a finding.
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CCE- | NIST800 | Built-in NSX Thoroughly review the deployment. Procedural (De-
8451 | 53-VI- If the virtual network is not isolated, this is a finding. pendent on Cus-
8-0 NET- tomer Configura-
CFG- tions)
00300
CCE- | NIST800 | Built-in NSX Do a thorough check on the infrastructure design and deployment network diagram. Procedural (De-
8451 | 53-VI- If there are any non-hypervisors on the logical network data plane or if any untrusted pendent on Cus-
9-8 | NET- hypervisors are used, this is a finding. tomer Configura-
CFG- tions)
00301
CCE- | NIST800 | Built-in NSX Use the vSphere Web Client to connect to the vCenter Server. As administrator, go to Home > | Reject
8452 | 53-VI- Inventory > Networking. Select “DSwitch” for distributed portgroups. Select each dvPortgroup
0-6 NET- connected to active VMs requiring securing. Go to tab Summary > Edit Settings > Policies >
CFG- Security.
00302 If Forged Transmits is not set to Reject, this is a finding.
CCE- | NIST800 | Built-in NSX Use the vSphere Web Client to connect to the vCenter Server. As administrator, go to Home > | Reject
8452 | 53-VI- Inventory > Networking. Select “DSwitch” for distributed portgroups. Select each dvPortgroup
1-4 NET- connected to active VMs requiring securing. Go to tab Summary > Edit Settings > Policies >
CFG- Security.
00303 If Mac Address Changes is not set to Reject, this is a finding.
CCE- | NIST800 | Built-in NSX Use the vSphere Web Client to connect to the vCenter Server. As administrator, go to Home > | Reject
8452 | 53-VI- Inventory > Networking. Select “DSwitch” for distributed portgroups. Select each dvPortgroup
2-2 NET- connected to active VMSs requiring securing. Go to tab Summary > Edit Settings > Policies >
CFG- Security.
00304 If Promiscuous Mode is not set to Reject, this is a finding.
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CCE- | NIST800 | Built-in NSX Log in to VMware vSphere Web Client. Navigate to Networking and Security --> Installation Load Balance -
8452 | 53-VI- and Upgrade. Go to the “Host Preparation” tab. Under the “VXLAN” column, select “View SRCID
3-0 NET- Configuration”.
CFG- If VMKNic Teaming Policy is not set to “Load Balance - SRCID”, this is a finding.
00306
CCE- | NIST800 | Built-in NSX Log into the vCenter web interface with credentials authorized for administration. Navigate to | Denied
8452 | 53-VI- Networking and Security >> Firewall. Expand “Default Section Layer 3” in Configuration.
4-8 NET- If the action for the Default Rule is “Allow”, this is a finding.
CFG-
00308
CCE- | NIST800 | Built-in NSX Log on to vSphere Web Client with credentials authorized for administration. Navigate and Procedural
8452 | 53-VI- select Networking and Security >> Users and Domains.
55 NET- View each role and verify the users and/or groups assigned to it.
CFG-
00311
CCE- | NIST800 | Built-in NSX From the vSphere Web Client, go to Administration >> Single Sign-On >> Configuration >> 1
8452 | 53-VI- Policies >> Password Policy. View the values of the password format requirements.
6-3 NET- If Numeric Characters is not set to at least 1, this is a finding.
CFG-
00312
CCE- | NIST800 | Built-in NSX From the vSphere Web Client, go to Administration >> Single Sign-On >> Configuration >> 1
8452 | 53-VI- Policies >> Password Policy. View the values of the password format requirements.
7-1 NET- If Special Characters is not set to at least 1, this is a finding.
CFG-
00313
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CCE- | NIST800 | Built-in NSX Log on to vSphere Web Client with credentials authorized for administration. Navigate and Procedural
8452 | 53-VI- select Networking and Security >> Users and Domains. View each role and verify the users
8-9 NET- and/or groups assigned to it.
CFG- If any user or service account has more privileges than required, this is a finding.
00316
CCE- | NIST800 | Built-in NSX Log into NSX Manager with built-in administrator account “admin” and default manufacturer Non-default pass-
8452 | 53-VI- password “default”. word
9-7 NET- If the NSX Manager accepts the default password, this is a finding.
CFG-
00317
CCE- | NIST800 | Built-in NSX Log into vSphere Web Client with credentials authorized for administration. Navigate to Procedural
8453 | 53-VI- Networking and Security >> Firewall. Expand rule sections as necessary to view rules.
0-5 NET- If there are no rules configured to enforce authorizations, this is a finding.
CFG-
00318
CCE- | NIST800 | Built-in NSX From the vSphere Web Client, go to Administration >> Single Sign-On >> Configuration >> 1
8453 | 53-VI- Policies >> Password Policy. View the values of the password format requirements.
1-3 NET- If Lower-Case Characters is not set to at least 1, this is a finding.
CFG-
00321
CCE- | NIST800 | Built-in NSX From the vSphere Web Client, go to Administration >> Single Sign-On >> Configuration >> 1
8453 | 53-VI- Policies >> Password Policy.
2-1 NET- If Upper-Case Characters is not set to at least 1, this is a finding.
CFG-
00322
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CCE- | NIST800 | Enhanced | NSX Log into vSphere Web Client with credentials authorized for administration. Navigate and Log
8453 | 53-VI- select Networking and Security >> Firewall tab to display a list of firewall rules deployed
3-9 NET- across the NSX environment. Click on the dropdown arrow to expand each firewall rule’s
CFG- section. For each rule, select the pencil icon in the “Action” column.
00323 If the “Log” option has not been enabled for all rules, this is a finding.
CCE- | NIST800 | Enhanced | NSX Log into vSphere Web Client with credentials authorized for administration. Navigate and Enabled
8453 | 53-VI- select Networking and Security >> SpoofGuard. Check the Default policy of each NSX
4-7 NET- Manager.
CFG- If the mode is disabled, this is a finding.
00324
CCE- | NIST800 | Built-in NSX Log onto vSphere Web Client with credentials authorized for administration. Navigate and Enabled
8453 | 53-VI- select Networking and Security >> select the NSX Edges tab on the left-side menu. Double-
5-4 NET- click the Edge ID. Navigate to Manage >> Verify the configurations under Settings, Firewall,
CFG- Routing, Bridging, and DHCP Relay are enabled only as necessary to the deployment.
00328 If unnecessary services are enabled, this is a finding.
CCE- | NIST800 | Built-in NSX If the built-in SSO administrator account is used for daily operations or there is no policy Procedural (De-
8453 | 53-VI- restricting its use, this is a finding. pendent on Cus-
6-2 NET- tomer Configura-
CFG- tions)
00329
CCE- | NIST800 | Built-in NSX From the vSphere Web Client, go to Administration >> Single Sign-On >> Configuration >> 5
8453 | 53-VI- Policies >> Password Policy.
7-0 NET- If Restrict Reuse is not set to “5” or more, this is a finding.
CFG-
00330
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CCE- | NIST800 | Built-in NSX Go to the vSphere Web Client URL https://client-hostname/vsphere-client and verify the CA Procedural
8453 | 53-VI- certificate is signed by an approved service provider.
8-8 NET- If a public key certificate from an appropriate certificate policy through an approved service

CFG- provider is not used, this is a finding.

00340
CCE- | NIST800 | Built-in NSX Log into vSphere Web Client with credentials authorized for administration. Navigate and Procedural
8453 | 53-VI- select Networking and Security >> Firewall.
9-6 NET- If there are services enabled that should not be, this is a finding.

CFG-

00343
CCE- | NIST800 | Built-in NSX Log into vSphere Web Client with credentials authorized for administration. Navigate and Procedural
8454 | 53-VI- select Networking and Security >> Firewall.
0-4 NET- If ports, protocols, and/or services are not disabled or restricted as required by the PPSM, this

CFG- is a finding.

00344
CCE- | NIST800 | Built-in NSX Log onto vSphere Web Client with credentials authorized for administration. Navigate and Procedural
8454 | 53-VI- select Networking and Security >> NSX Edges tab on the left-side menu. Double-click the
1-2 NET- EdgelD. Click on the Configure tab on the top of the new screen, then Interfaces >> Check the

CFG- “Connection Status” column for the associated interface.

00360 If any inactive router interfaces are not disabled, this is a finding.
CCE- | NIST800 | Built-in NSX Log on to NSX Manager with credentials authorized for administration. Navigate and select Procedural
8454 | 53-VI- Backup and Restore >> Backup History.
2-0 NET- If backups are not being sent to a centralized location when changes occur or weekly,

CFG- whichever is sooner, this is a finding.

00372
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CCE- | NIST800 | Enhanced | vCent | Ask the system administrator if hardened, patched templates are used for VM creation, Hardened virtual
8430 | 53-VI- er properly configured OS deployments, including applications both dependent and non- machine templates
1-1 VC-CFG- dependent on VM-specific configurations. to use for OS de-
00060 If hardened, patched templates are not used for VM creation, this is a finding. The system ployments.
must use templates to deploy VMs whenever possible.
CCE- | NIST800 | Enhanced | vCent | Onthe Home page of the vSphere Client, select Menu > Administration and click Roles. Select | Disable Console in-
8430 | 53-VI- er the VC from the Roles provider drop-down menu. Select the Virtual machine user (sample) teraction privilege
2-9 ESXI- role and click Privileges.
CFG- If the Console Interaction privilege is assigned to the role, this is a finding. If SSH and/or
00061 terminal management services are exclusively used to perform management tasks, this is not
a finding.
CCE- | NIST800 | Built-in vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run Disconnect unau-
8430 | 53-VI- er the following command: thorized parallel
3-7 ESXI- Get-VM | Where devices
CFG- {$_.ExtensionData.Config.Hardware.Device.DeviceInfo.Label -match
00065 ""parallel""}
If a virtual machine has a parallel device present, this is a finding.
CCE- | NIST800 | Built-in vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run Disconnect unau-
8430 | 53-VI- er the following command: thorized serial de-
4-5 ESXI- Get-VM | Where vices
CFG- {$_.ExtensionData.Config.Hardware.Device.DeviceInfo.Label -match
00066 ""serial""}
If a virtual machine has a serial device present, this is a finding.
CCE- | NIST800 | Built-in vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run No USB device pre-
8430 | 53-VI- er the following command: sent
5-2 ESXI- Get-VM | Get-UsbDevice
CFG- If a virtual machine has any USB devices or USB controllers present, this is a finding.
00067
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CCE- | NIST800 | Built-in vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run Remove the ad-
8430 | 53-VI- er the following command: vanced setting
6-0 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name sched.mem.pshare.salt sched.mem.pshare
CFG- If sched.mem.pshare.salt exists, this is a finding. salt
00068
CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8430 | 53-VI- er the following command:
7-8 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name
CFG- isolation.tools.copy.disable
00070 If isolation.tools.copy.disable does not exist or is not set to true, this is a finding.
CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8430 | 53-VI- er the following command:
8-6 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name
CFG- isolation.tools.dnd.disable
00071 If isolation.tools.dnd.disable does not exist or is not set to true, this is a finding.
CCE- | NIST800 | Enhanced | vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run FALSE
8430 | 53-VI- er the following command:
9-4 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name
CFG- isolation.tools.setGUIOptions.enable
00072 If isolation.tools.setGUIOptions.enable does not exist or is not set to false, this is a finding.
CCE- | NIST800 | Enhanced | vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run TRUE
8431 | 53-VI- er the following command:
0-2 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name
CFG- isolation.tools.paste.disable
00073 If isolation.tools.paste.disable does not exist or is not set to true, this is a finding.
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CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8431 | 53-VI- er the following command:
1-0 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.diskShrink.disable

00074 If isolation.tools.diskShrink.disable does not exist or is not set to true, this is a finding.
CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8431 | 53-VI- er the following command:
2-8 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.diskWiper.disable

00075 If isolation.tools.diskWiper.disable does not exist or is not set to true, this is a finding.
CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8431 | 53-VI- er the following command:
3-6 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.hgfsServerSet.disable

00076 If isolation.tools.hgfsServerSet.disable does not exist or is not set to true, this is a finding.
CCE- | NIST800 | Enhanced | vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run TRUE
8431 | 53-VI- er the following command:
4-4 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.ghi.autologon.disable

00077 If isolation.tools.ghi.autologon.disable does not exist or is not set to true, this is a finding.
CCE- | NIST800 | Enhanced | vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run TRUE
8431 | 53-VI- er the following command:
5-1 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name isolation.bios.bbs.disable

CFG- If isolation.bios.bbs.disable does not exist or is not set to true, this is a finding.

00078
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CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8431 | 53-VI- er the following command:
6-9 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.getCreds.disable

00079 If isolation.tools.getCreds.disable does not exist or is not set to true, this is a finding.
CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8431 | 53-VI- er the following command:
7-7 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.ghi.launchmenu.change

00080 If isolation.tools.ghi.launchmenu.change does not exist or is not set to true, this is a finding.
CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8431 | 53-VI- er the following command:
8-5 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.memSchedFakeSampleStats.disable

00081 If isolation.tools.memSchedFakeSampleStats.disable does not exist or is not set to true, this is

a finding.

CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8431 | 53-VI- er the following command:
9-3 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.ghi.protocolhandler.info.disable

00082 If isolation.tools.ghi.protocolhandler.info.disable does not exist or is not set to true, this is a

finding.

CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8432 | 53-VI- er the following command:
0-1 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.ghi.host.shellAction.disable

00083 If isolation.ghi.host.shellAction.disable does not exist or is not set to true, this is a finding.
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CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8432 | 53-VI- er the following command:
1-9 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.dispTopoRequest.disable

00084 If isolation.tools.dispTopoRequest.disable does not exist or is not set to true, this is a finding.
CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8432 | 53-VI- er the following command:
2-7 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.trashFolderState.disable

00085 If isolation.tools.trashFolderState.disable does not exist or is not set to true, this is a finding.
CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8432 | 53-VI- er the following command:
3-5 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.ghi.trayicon.disable

00086 If isolation.tools.ghi.trayicon.disable does not exist or is not set to true, this is a finding.
CCE- | NIST800 | Enhanced | vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run TRUE
8432 | 53-VI- er the following command:
4-3 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.unity.disable

00087 If isolation.tools.unity.disable does not exist or is not set to true, this is a finding.
CCE- | NIST800 | Enhanced | vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run TRUE
8432 | 53-VI- er the following command:
5-0 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.unityInterlockOperation.disable

00088 If isolation.tools.unitylnterlockOperation.disable does not exist or is not set to true, this is a

finding.
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CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8432 | 53-VI- er the following command:
6-8 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.unity.push.update.disable

00089 If isolation.tools.unity.push.update.disable does not exist or is not set to true, this is a finding.
CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8432 | 53-VI- er the following command:
7-6 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.unity.taskbar.disable

00090 If isolation.tools.unity.taskbar.disable does not exist or is not set to true, this is a finding.
CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8432 | 53-VI- er the following command:
8-4 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.unityActive.disable

00091 If isolation.tools.unityActive.disable does not exist or is not set to true, this is a finding.
CCE- | NIST800 | Enhanced | vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run TRUE
8432 | 53-VI- er the following command:
9-2 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.unity.windowContents.disable

00092 If isolation.tools.unity.windowContents.disable does not exist or is not set to true, this is a

finding.

CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8433 | 53-VI- er the following command:
0-0 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.vmxDnDVersionGet.disable

00093 If isolation.tools.vmxDnDVersionGet.disable does not exist or is not set to true, this is a

finding.
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CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8433 | 53-VI- er the following command:
1-8 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.guestDnDVersionSet.disable

00094 If isolation.tools.guestDnDVersionSet.disable does not exist or is not set to true, this is a

finding.

CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8433 | 53-VI- er the following command:
2-6 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.vixMessage.disable

00095 If isolation.tools.vixMessage.disable does not exist or is not set to true, this is a finding.
CCE- | NIST800 | Enhanced | vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run 1
8433 | 53-VI- er the following command:
3-4 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- RemoteDisplay.maxConnections

00096 If RemoteDisplay.maxConnections does not exist or is not set to 1, this is a finding.
CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run FALSE
8433 | 53-VI- er the following command:
4-2 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name RemoteDisplay.vnc.enabled

CFG- If RemoteDisplay.vnc.enabled does not exist or is not set to false, this is a finding.

00097
CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8433 | 53-VI- er the following command:
5-9 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.tools.autoInstall.disable

00098 If isolation.tools.autolnstall.disable does not exist or is not set to true, this is a finding.
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CCE- | NIST800 | Enhanced | vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run 1048576
8433 | 53-VI- er the following command:
6-7 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name tools.setinfo.sizelLimit

CFG- If tools.setinfo.sizeLimit does not exist or is not set to 1048576, this is a finding.

00099
CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8433 | 53-VI- er the following command:
7-5 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.device.edit.disable

00100 If isolation.device.edit.disable does not exist or is not set to true, this is a finding.
CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run TRUE
8433 | 53-VI- er the following command:
8-3 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- isolation.device.connectable.disable

00101 If isolation.device.connectable.disable does not exist or is not set to true, this is a finding.
CCE- | NIST800 | Enhanced | vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run FALSE
8433 | 53-VI- er the following command:
9-1 ESXI- Get-VM "VM Name" | Get-AdvancedSetting -Name

CFG- tools.guestlib.enableHostInfo

00102 If tools.guestlib.enableHostInfo does not exist or is not set to false, this is a finding.
CCE- | NIST800 | Built-in vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run Persistent
8434 | 53-VI- er the following command:
0-9 ESXI- Get-VM "VM Name" | Get-HardDisk | Select Parent, Name, Filename,

CFG- DiskType, Persistence | FT -AutoSize

00154 If the virtual machine has attached disks that are in independent nonpersistent mode, this is a

finding.
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CCE- | NIST800 | Built-in vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run Disconnect unau-
8434 | 53-VI- er the following command: thorized floppy de-
1-7 ESXI- Get-VM | Get-FloppyDrive | Select Parent, Name, ConnectionState vices

CFG- If a virtual machine has a floppy drive present, this is a finding.

00155
CCE- | NIST800 | Built-in vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run Disconnect unau-
8434 | 53-VI- er the following command: thorized CD/DVD
2-5 ESXI- Get-VM | Get-CDDrive | Where {$_.extensiondata.connectable.connected - drives

CFG- eq S$true} | Select Parent,Name

00156 If a virtual machine has a CD/DVD drive connected other than temporarily, this is a finding.
CCE- | NIST800 | Built-in vCent | From a PowerCLI command prompt, while connected to the ESXi host run the following Not 4095
8434 | 53-VI- er command:
3-3 ESXI- Get-VirtualPortGroup | Select Name, VLanID

CFG- If any port group is configured with VLAN 4095 and is not documented as a needed exception,

00185 this is a finding.
CCE- | NIST800 | Built-in vCent | If the vCenter server is not joined to an Active Directory domain and not configured for Single Procedural (De-
8434 | 53-VI- er Sign-On Identity Source of the Active Directory domain, and Active Directory/CAC/PIV pendent on Cus-
4-1 NET- certificate-based accounts are not used for daily operations of the vCenter server, this is a tomer Configura-

CFG- finding. tions)

00341
CCE- | NIST800 | Built-in vCent | If the vCenter server is not joined to an Active Directory domain and not configured for Single Procedural (De-
8434 | 53-VI- er Sign-On Identity Source of the Active Directory domain, and Active Directory/CAC/PIV pendent on Cus-
5-8 NET- certificate-based accounts are not used for daily operations of the vCenter server, this is a tomer Configura-

CFG- finding. tions)

00341
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CCE- | NIST800 | Built-in vCent | From a PowerCLI command prompt, while connected to the vCenter server run the following Not 4095
8434 | 53-VI- er command:
7-4 VC-CFG- Get-VDPortgroup | select Name, VlanConfiguration
00402 If any port group is configured with VLAN 4095 and is not documented as a needed exception,
this is a finding.
CCE- | NIST800 | Built-in vCent | From the vSphere Web Client go to Administration >> Single Sign-On >> Configuration >> 5
8434 | 53-VI- er Policies >> Password Policy.
8-2 VC-CFG- If Restrict Reuse is not set to 5 or more, this is a finding.
00403
CCE- | NIST800 | Built-in vCent | From a PowerCLI command prompt, while connected to the vCenter server run the following info
8434 | 53-VI- er command:
9-0 VC-CFG- Get-AdvancedSetting -Entity <vcenter server name> -Name
00404 config.log.level
If the level is not set to info, this is a finding.
CCE- | NIST800 | Built-in vCent | From a PowerCLI command prompt, while connected to the vCenter server run the following reject
8435 | 53-VI- er commands:
0-8 VC-CFG- Get-VDSwitch | Get-VDSecurityPolicy
00405 Get-VDPortgroup | Get-VDSecurityPolicy
If the Promiscuous Mode policy is set to accept, this is a finding.
CCE- | NIST800 | Built-in vCent | From the vSphere Web Client go to Administration >> Client Plug-Ins. View the N/A
8435 | 53-VI- er Installed/Available Plug-ins list and verify they are all identified as authorized VMware, 3rd
1-6 VC-CFG- party (Partner) and/or site-specific (locally developed and site) approved plug-ins.
00406 If any Installed/Available plug-ins in the viewable list cannot be verified as vSphere Client plug-
ins and/or authorized extensions from trusted sources, this is a finding.
CCE- | NIST800 | Built-in vCent | From a PowerCLI command prompt, while connected to the vCenter server run the following Authorized exten-
8435 | 53-VI- er commands: sions from Trusted
2-4 Sources
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VC-CFG- Get-VDSwitch | Get-VDSecurityPolicy
00407 Get-VDPortgroup | Get-VDSecurityPolicy
If the MAC Address Changes policy is set to accept, this is a finding.
CCE- | NIST800 | Built-in vCent | From the vSphere Web Client go to Administration >> Single Sign-On >> Configuration >> 1
8435 | 53-VI- er Policies >> Password Policy.
3-2 VC-CFG- If Upper-Case Characters is not set to at least 1, this is a finding.
00408
CCE- | NIST800 | Built-in vCent | From a PowerCLI command prompt, while connected to the vCenter server run the following enabled
8435 | 53-VI- er command:
4-0 VC-CFG- Get-VDSwitch | select Name, @ {N="NIOC
00409 Enabled";E={$ .ExtensionData.config.NetworkResourceManagementEnabled}}
If Network 1/0 Control is disabled, this is a finding.
CCE- | NIST800 | Enhanced | vCent | From the vSphere Web Client go to Administration >> Single Sign-On >> Configuration >> 15
8435 | 53-VI- er Policies >> Password Policy.
5-7 VC-CFG- If the Minimum Length is not set to at least 15, this is a finding.
00410
CCE- | NIST800 | Enhanced | vCent | From a PowerCLI command prompt, while connected to the vCenter server run the following FALSE
8435 | 53-VI- er commands:
6-5 VC-CFG- Svds = Get-VDSwitch
00411 $vds.ExtensionData.Config.HealthCheckConfig
If the health check feature is enabled on distributed switches and is not on temporarily for
troubleshooting purposes, this is a finding.
CCE- | NIST800 | Enhanced | vCent | From the vSphere Client, select the vCenter server at the top of the hierarchy and go to Procedural
8435 | 53-VI- er Alarms >> Definitions.
7-3 VC-CFG- or
00412

From a PowerCLI command prompt, while connected to the vCenter server run the following
command:
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Get-AlarmDefinition | Where
{$_.ExtensionData.Info.Expression.Expression.EventTypeld -eq
"vim.event.PermissionUpdatedEvent"} | Select
Name, Enabled, @ {N="EventTypeId";E={$ .ExtensionData.Info.Expression.Expr
ession.EventTypelId}}
If there is not an alarm created to alert on permission update events, this is a finding.

CCE- | NIST800 | Built-in vCent | From the vSphere Web Client go to Administration >> Single Sign-On >> Configuration >> 1

8435 | 53-VI- er Policies >> Password Policy.

8-1 VC-CFG- If Lower-Case Characters is not set to at least 1, this is a finding.

00413

CCE- | NIST800 | Enhanced | vCent | From the vSphere Client, select the vCenter server at the top of the hierarchy and go to Procedural

8435 | 53-VI- er Alarms >> Definitions.

9-9 VC-CFG- or

00414 From a PowerCLlI command prompt, while connected to the vCenter server run the following

command:
Get-AlarmDefinition | Where
{$_.ExtensionData.Info.Expression.Expression.EventTypeld -eq
"vim.event.PermissionAddedEvent"} | Select
Name, Enabled, @ {N="EventTypeId";E={S$S .ExtensionData.Info.Expression.Expr
ession.EventTypelId}}
If there is not an alarm created to alert on permission addition events, this is a finding.

CCE- | NIST800 | Built-in vCent | From the vSphere Web Client, go to Administration >> Access Control >> Roles. Procedural (De-

8436 | 53-VI- er or pendent on Cus-

0-7 :)lgfl;G' From a PowerCLlI command prompt, while connected to the vCenter server run the following tF)me)r Configura-

tions

command:

Get-VIPermission | Sort Role | Select
Role,Principal,Entity, Propagate, IsGroup | FT -Auto

Application service account and user required privileges should be documented.
If any user or service account has more privileges than required, this is a finding.

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud laaS Environments

110




DRAFT

CCE Configur

Built-In/

Prod-

Audit Procedure

Recommended

ID ation(s) Enhanced uct Parameter Value
CCE- | NIST800 | Enhanced | vCent | From the vSphere Client, select the vCenter server at the top of the hierarchy and go to Procedural
8436 | 53-VI- er Alarms >> Definitions.
1-5 VC-CFG- or
00416 From a PowerCLlI command prompt, while connected to the vCenter server run the following
command:
Get-AlarmDefinition | Where
{$_.ExtensionData.Info.Expression.Expression.EventTypeld -eq
"vim.event.PermissionRemovedEvent"} | Select
Name, Enabled, @ {N="EventTypeId";E={$ .ExtensionData.Info.Expression.Expr
ession.EventTypelId}}
If there is not an alarm to alert on permission deletion events, this is a finding.
CCE- | NIST800 | Built-in vCent | From a PowerCLI command prompt, while connected to the vCenter server run the following Known lps
8436 | 53-VI- er command:
2-3 VC-CFG- Get-VDPortgroup | Select
00417 Name,VirtualSwitch, @{N="NetFlowEnabled";E={$ .Extensiondata.Config.defa
ultPortConfig.ipfixEnabled.Value}}
If NetFlow is configured and the collector IP is not known and is not enabled temporarily for
troubleshooting purposes, this is a finding.
CCE- | NIST800 | Enhanced | vCent | If no clusters are enabled for VSAN, this is not applicable. Procedural
8436 | 53-VI- er From the vSphere Web Client go to Host and Clusters >> Select a vCenter Server >>
3-1 | VC-CFG- Configure >> vSAN >> Internet Connectivity >> Status.
00418 If a proxy is not configured, this is a finding.
CCE- | NIST800 | Built-in vCent | From a PowerCLI command prompt, while connected to the vCenter server run the following Procedural (De-
8436 | 53-VI- er command: pendent on Cus-
4-9 VC-CFG- Get-VIPermission | Sort Role | Select tomer Configura-
00419 Role, Principal,Entity, Propagate, IsGroup | FT -Auto tions)

Application service account and user required privileges should be documented.
If any user or service account has more privileges than required, this is a finding.

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud laaS Environments

111




DRAFT

CCE Configur

Built-In/

Prod-

Audit Procedure

Recommended

ID ation(s) Enhanced uct Parameter Value
CCE- | NIST800 | Built-in vCent | From the vSphere Web Client, go to Host and Clusters >> Select a Cluster >> Related No name with
8436 | 53-VI- er Objects >> Datastores. Review the datastores. Identify any datastores with “vsan” as the “vsanDatastore”
5-6 VC-CFG- datastore type.
00420 or
From a PowerCLlI command prompt, while connected to the vCenter server run the following
command:
If($(Get-Cluster | where {$_.VsanEnabled} | Measure) .Count -gt 0) {
Write-Host "VSAN Enabled Cluster found"
Get-Cluster | where {$_.VsanEnabled} | Get-Datastore | where {$ .type -
match "vsan"}
}
else(
Write-Host "VSAN is not enabled, this finding is not applicable"
}
If VSAN is enabled and the datastore is named “vsanDatastore”, this is a finding.
CCE- | NIST800 | Enhanced | vCent | From the vSphere Web Client, go to Administration >> Single Sign-On >> Configuration >> 60
8436 | 53-VI- er Policies >> Password Policy.
6-4 | VC-CFG- If Maximum Lifetime is not set to 60, this is a finding.
00421
CCE- | NIST800 | Enhanced | vCent | On the system where vCenter is installed, locate the webclient.properties file. 10
8436 | 53-VI- er /etc/vmware/vsphere-client/ and /etc/vmware/vsphere-ui/
7-2 VC-CFG- If session.timeout is not set to 10 (minutes), this is a finding.
00422
CCE- NISTS800 Enhanced | vCent | Get-AdvancedSetting -Entity <vcenter server name> -Name 32
8436 | 53-VI- er config.vpxd.hostPasswordLength
8-0 VC-CFG-
00427
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CCE- | NIST800 | Built-in vCent | From the vSphere Web Client, go to vCenter Inventory Lists >> vCenter Servers >> Select your | FALSE
8436 | 53-VI- er vCenter Server >> Settings >> Advanced System Settings.
9-8 | VC-CFG- or
00428 From a PowerCLlI command prompt, while connected to the vCenter server run the following
command:
Get-AdvancedSetting -Entity <vcenter server name> -Name
VirtualCenter.VimPasswordExpirationInDays
If VirtualCenter.VimPasswordExpirationInDays is set to a value other than 30 or does not exist,
this is a finding.
CCE- | NIST800 | Built-in vCent | Check the following conditions: Procedural
8437 | 53-VI- er 1. The Update Manager must be configured to use the Update Manager Download Server.
0-6 VC-CFG- 2. The use of physical media to transfer update files to the Update Manager server (air-gap
00429 model example: separate Update Manager Download Server which may source vendor
patches externally via the Internet versus an internal source) must be enforced with site
policies.
To verify download settings, from the vSphere Client/vCenter Server system, click Update
Manager. Select a Host and then click the Settings tab. In the Download Settings tab, find
“Direct connection to Internet”.
If “Direct connection to Internet” is configured, this is a finding.
If all of the above conditions are not met, this is a finding.
CCE- | NIST800 | Built-in vCent | From the vSphere Web Client, go to Administration >> Single Sign-On >> Configuration >> 1
8437 | 53-VI- er Policies >> Password Policy.
1-4 | VC-CFG- If Special Characters is not set to at least 1, this is a finding.
00432
CCE- | NIST800 | Built-in vCent | From the vSphere Web Client, go to Administration >> Single Sign-On >> Configuration >> 1
8437 | 53-VI- er Policies >> Password Policy.
2-2

If Numeric Characters is not set to at least 1, this is a finding.
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VC-CFG-
00433
CCE- | NIST800 | Enhanced | vCent | From the vSphere Web Client, go to Administration >> Single Sign-On >> Configuration >> 900
8437 | 53-VI- er Policies >> Lockout Policy.
3-0 | VCCFG- If the Time interval between failures is not set to at least 900, this is a finding.
00434
CCE- | NIST800 | Enhanced | vCent | From the vSphere Web Client, go to Administration >> Single Sign-On >> Configuration >> 0
8437 | 53-VI- er Policies >> Lockout Policy.
4-8 | VC-CFG- If the Unlock time is not set to 0, this is a finding.
00435
CCE- | NIST800 | Enhanced | vCent | From the vSphere Web Client, go to Administration >> Single Sign-On >> Configuration >> 3
8437 | 53-VI- er Policies >> Lockout Policy.
5-5 VC-CFG- If the Maximum number of failed login attempts is not set to 3, this is a finding.
00436
CCE- | NIST800 | Enhanced | vCent | From the vSphere Web Client go to vCenter Inventory Lists >> vCenter Servers >> Select your | TRUE
8437 | 53-VI- er vCenter Server >> Settings >> Advanced Settings.
6-3 VC-CFG- or
00437 From a PowerCLI command prompt, while connected to the vCenter server run the following
command:
Get-AdvancedSetting -Entity <vcenter server name> -Name
config.nfc.useSSL
If config.nfc.useSSL is not set to true, this is a finding.
CCE- | NIST800 | Built-in vCent | If the built-in SSO administrator account is used for daily operations or there is no policy Procedural
8437 | 53-VI- er restricting its use, this is a finding.
7-1 VC-CFG-
00439
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CCE- | NIST800 | Enhanced | vCent | From the vSphere Web Client, go to Networking >> Select a distributed port group >> disabled

8437 | 53-VI- er Manage >> Settings >> Properties. View the Override port policies.

8-9 VC-CFG- or

00440 From a PowerCLlI command prompt, while connected to the vCenter server run the following

command:
Get-VDPortgroup | Get-View |
Select Name,
@{N="VlanOverrideAllowed";E={$ .Config.Policy.VlanOverrideAllowed}},
@{N="UplinkTeamingOverrideAllowed";E={$ .Config.Policy.UplinkTeamingOve
rrideAllowed}},
@{N="SecurityPolicyOverrideAllowed";E={$ .Config.Policy.SecurityPolicyO
verrideAllowed}},
@{N="IpfixOverrideAllowed";E={$_ .Config.Policy.IpfixOverrideAllowed}},
@{N="BlockOverrideAllowed";E={$_ .Config.Policy.BlockOverrideAllowed}},
@{N="ShapingOverrideAllowed";E={$ .Config.Policy.ShapingOverrideAllowed
by
@ {N="VendorConfigOverrideAllowed";E={S$ .Config.Policy.VendorConfigOverr
ideAllowed}},
@{N="TrafficFilterOverrideAllowed";E={$ .Config.Policy.TrafficFilterOve
rrideAllowed}},
@{N="PortConfigResetAtDisconnect";E={S$ .Config.Policy.PortConfigResetAt
Disconnect}} | Sort Name
Note: This was broken up into multiple lines for readability. Either paste as is into a PowerShell
script or combine into one line and run.
This does not apply to the reset port configuration on disconnect policy.
If any port level overrides are enabled and not documented, this is a finding.

CCE- | NIST800 | Enhanced | vCent | From the vSphere Client, select the vCenter server at the top of the hierarchy and go to Enabled

8437 | 53-VI- er Alarms >> Definitions.

9-7 VC-CFG- or

00442
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From a PowerCLI command prompt, while connected to the vCenter server run the following
command:
Get-AlarmDefinition | Where
{$_.ExtensionData.Info.Expression.Expression.EventTypeld -eq
"esx.problem.vmsyslogd.remote.failure"} | Select
Name, Enabled, @ {N="EventTypeId";E={$ .ExtensionData.Info.Expression.Expr
ession.EventTypelId}}
If there is no alarm created to alert if an ESXi host can no longer reach its syslog server, this is
a finding.
CCE- | NIST800 | Built-in vCent | If IP-based storage is not used, this is not applicable. Unique IP Ad-
8438 | 53-VI- er IP-based storage (iSCSI, NFS, VSAN) VMkernel port groups must be in a dedicated VLAN that dresses
0-5 VC-CFG- can be on a common standard or distributed virtual switch that is logically separated from
00445 other traffic types. The check for this will be unique per environment.
From the vSphere Client, select Networks >> Distributed Port Groups and review the VLANs
associated with any IP-based storage VMkernels.
If any IP-based storage networks are not isolated from other traffic types, this is a finding.
CCE- | NIST800 | Built-in vCent | Login to the vCenter server and view the local administrators group membership. Only necessary us-
8438 | 53-VI- er If the local administrators group contains users and/or groups that are not vCenter ers and groups
1-3 VC-CFG- Administrators such as “Domain Admins”, this is a finding.
00447
CCE- | NIST800 | Built-in vCent | From the vSphere Client, go to Home >> Networking. Select a distributed port group, click reject
8438 | 53-VI- er Edit, then go to Security.
2-1 | VC-CFG- or
00450

From a PowerCLlI command prompt, while connected to the vCenter server run the following
commands:

Get-VDSwitch | Get-VDSecurityPolicy

Get-VDPortgroup | ?{$_ .IsUplink -eq $false} | Get-VDSecurityPolicy

If the Forged Transmits policy is set to accept for a non-uplink port, this is a finding.
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CCE- | NIST800 | Enhanced | vCent | If the vSphere Storage API - Data Protection (VADP) solution is not configured for performing vSphere Storage
8438 | 53-VI- er backup and restore of the management components, this is a finding. API - Data Protec-
3-9 | VC-CFG- tion (VADP)
00455
CCE- | NIST800 | Built-in vCent | On the Edit port group - VM Network window, check for input 1611 for VLAN ID. Not 1611
8438 | 53-VI- er If the vlan is 1611, this is a finding.
4-7 VC-CFG-
00497
CCE- | NIST800 | Enhanced | vCent | From a PowerCLI command prompt, while connected to the ESXi host or vCenter server run TRUE
8438 | 53-VI- er the following command:
5-4 VC-CFG- Get-VM "VM Name" | Get-AdvancedSetting -Name svga.vgaonly
00555 If svga.vgaonly does not exist or is not set to false, this is a finding.
CCE- NIST800 | Enhanced | vCent | From a PowerCLlI command prompt, while connected to the ESXi host or vCenter server run FALSE
8438 | 53-VI- er the following command:
6-2 VC-CFG- Get-VM "VM Name" | Get-AdvancedSetting -Name pciPassthru*.present
00561 If pciPassthru*.present does not exist or is not set to false, this is a finding.
CCE- | NIST800 | Enhanced | vSAN | From a PowerCLI command prompt, while connected to the vCenter server run the following No Cryptography
8460 | 53-VI- command: Administrator
14 Storage- Get-VIPermission | Where {$ .Role -eq "Admin"} | Select
SDS- Role,Principal,Entity, Propagate, IsGroup | FT -Auto
CFG- If there are any users other than Solution Users with the Administrator role that are not
00178 explicitly designated for cryptographic operations, this is a finding.
CCE- | NIST800 | Built-in vSAN | From a PowerCLI command prompt, while connected to the ESXi host run the following Correct date and
8460 | 53-VI- commands: timestamp
2-2 Storage- Get-VMHost | Get-VMHostNTPServer
SDS- Get-VMHost | Get-VMHostService | Where {$ .Label -eg "NTP Daemon"}
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CFG- If the NTP service is not configured with authoritative DoD time sources and the service is not
00180 configured to start and stop with the host and is running, this is a finding.
CCE- | NIST800 | Built-in VSAN | Log in to the vRealize Log Insight user interface. Click the configuration drop-down menu icon VMware - vSAN
8460 | 53-VI- and select Content Packs. Under Content Pack Marketplace, select Marketplace.
3-0 Storage- If the VMware - vSAN content pack does not appear in the Installed Content Packs list, this is a
SDs- finding.
CFG-
00181
CCE- | NIST800 | Built-in VSAN | From a PowerCLI command prompt, while connected to the ESXi host run the following 900
8460 | 53-VI- command:
4-8 Storage- Get-VMHost | Get-AdvancedSetting -Name
SDS- UserVars.HostClientSessionTimeout
CFG- If UserVars.HostClientSessionTimeout is not set to 900, this is a finding.
00182
CCE- | NIST800 | Enhanced | vSAN | From the vSphere client, select the cluster. Click the Configure tab and under vSAN, click Enabled
8460 | 53-VI- Services.
5-5 Storage- If Encryption is not enabled or the KMS cluster is not configured, this is a finding.
SDS-
CFG-
00183
CCE- | NIST800 | Built-in VSAN | Perform a compliance check on the inventory objects to make sure that you have all the latest | Up-to-Date
8460 | 53-VI- security patches and updates applied. Use the vSphere Client to log in to a vCenter Server Patches and Up-
6-3 Storage- Appliance, or to a vCenter Server system with which Update Manager is registered. grades
SDs- If all the latest security patches and updates are not applied, this is a finding.
CFG-
00184

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud laaS Environments

118




DRAFT

CCE Configur

Built-In/

Prod-

Audit Procedure

Recommended

ID ation(s) Enhanced uct Parameter Value
CCE- NIST800 | Built-in VvSAN From a PowerCLI command prompt, while connected to the ESXi host run the following udp://sfo01vrli0l.s
8460 | 53-VI- command: foO1l.rainpole.lo-
7-1 Storage- Get-VMHost | Get-AdvancedSetting -Name Syslog.global.logHost cal:514

SDs- If Syslog.global.logHost is not set to a site-specific syslog server, this is a finding.

CFG-

00185
CCE- | NIST800 | Enhanced | vSAN | From a PowerCLI command prompt, while connected to the vCenter server run the following No Cryptography
8460 | 53-VI- command: Administrator
8-9 Storage- Get-VIPermission | Where {$ .Role -eq "Admin"} | Select

SDS- Role,Principal, Entity, Propagate, IsGroup | FT -Auto

CFG- If there are any users other than Solution Users with the Administrator role that are not

00204 explicitly designated for cryptographic operations, this is a finding.
CCE- | NIST800 | Enhanced | vSAN | If VSAN Health Check is installed: Proxy should be
8460 | 53-VI- From the vSphere Client, go to Host and Clusters. Select a vCenter Server and go to configured
9-7 Storage- Configure > vSAN > Internet Connectivity > Status.

SDs- If “Enable Internet access for this cluster” is enabled and a proxy is not configured, this is a

CFG- finding.

00207
CCE- | NIST800 | Built-in VSAN | From a PowerCLI command prompt, while connected to the vCenter server run the following Datastore name is
8461 | 53-VI- command: unique
0-5 Storage- If($(Get-Cluster | where {$ .VsanEnabled} | Measure).Count -gt 0) {

SDS- Write-Host "VSAN Enabled Cluster found"

CFG- Get-Cluster | where {$_ .VsanEnabled} | Get-Datastore | where {$ .type -

00208 match "vsan"}

}

else{

Write-Host "VSAN is not enabled, this finding is not applicable"
}

If VSAN is enabled and the datastore is named “vsanDatastore”, this is a finding.
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CCE- | NIST800 | Enhanced | vSAN | From a PowerCLI command prompt, while connected to the ESXi host run the following TRUE
8461 | 53-VI- commands:
1-3 Storage- $esxcli = Get-EsxCli

SDS- Sesxcli.system.coredump.network.get ()

CFG- If there is no active core dump partition or the network core dump collector is not configured

00179 and enabled, this is a finding.
CCE- | NIST800 | Enhanced | vSAN | Make sure you have sufficient capacity in the management vSAN cluster for the management Procedural
8461 | 53-VI- virtual machines.
2-1 Storage- If you do not have sufficient capacity, this is a finding.

SDS-

CFG-

00186
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Active Directory

Application Programming Interface
Basic Input/Output System

Bill of Materials

Certificate Authority

Common Access Card

Content Addressable Memory
Common Configuration Enumeration
Command Line Interface

Cooperative Research and Development Agreement
Dell EMC Unity Data at Rest Encryption
Dynamic Host Configuration Protocol
Defense Information Systems Agency
Domain Name System

Department of Defense

Extensible Firmware Interface

Federal Information Processing Standards
File Transfer Protocol

Gigabyte

Gigahertz

Good Known Host

Graphical User Interface

Hardware Security Module

HyTrust CloudControl

Infrastructure as a Service

IBM Cloud Secure Virtualization
Input/Output Operations per Second
Internet Protocol

Internet Protocol Security

Information Technology

Key Management System

NIST SP 1800-19C: Trusted Cloud: Security Practice Guide for VMware Hybrid Cloud laaS Environments

121



DRAFT

LACP
LLDP
MAC
MLE
MOB
NCCoE
NFS
NIC
NIST
NISTIR
NSX-V
NTLS
NTP
oS
OSPF
ou
OVA
PDC
PIV
PSC
PXE
RAM
RPC
SAS
SCslI
SDDC
SED
SFTP
SHA
SLES
SMTP
SNMP

Link Aggregation Control Protocol
Link Layer Discovery Protocol
Media Access Control

Measured Launch Environment
(vCenter) Managed Object Browser
National Cybersecurity Center of Excellence
Network File System

Network Interface Card

National Institute of Standards and Technology
National Institute of Standards and Technology Interagency Report
NSX for vSphere

Network Trust Links

Network Time Protocol

Operating System

Open Shortest Path First
Organizational Unit

Open Virtual Appliance

Physical Data Center

Personal Identity Verification
Platform Services Controller
Preboot Execution Environment
Random Access Memory

Remote Procedure Call

Serial Attached SCSI

Small Computer System Interface
Software Defined Data Center
Self-Encrypting Drive

Secure File Transfer Protocol
Secure Hash Algorithm

SUSE Linux Enterprise Server
Simple Mail Transfer Protocol

Simple Network Management Protocol
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SP
SSD
SSH
SSO
STIG
TB
TCP
TLS
TPM
TXT
UCR
UEFI
ul
UMDS
URL
usB
uuID
VADP
VCF
VCs
VLAN
VM
VMX
VPN
VR
VRA
vRLI
VvROPS
VSAN
VSl

VVD

Special Publication, Storage Processor
Solid State Drive

Secure Shell

Single Sign-On

Security Technical Implementation Guide
Terabyte

Transmission Control Protocol
Transport Layer Security

Trusted Platform Module

Trusted Execution Technology
Unified Capabilities Requirements
Unified Extensible Firmware Interface
User Interface

Update Manager Download Service
Uniform Resource Locator

Universal Serial Bus

Universally Unique Identifier

vSphere Storage APIs for Data Protection
VMware Cloud Foundation

vCenter Server

Virtual Local Area Network

Virtual Machine

Virtual Machine Extensions

Virtual Private Network

vSphere Replication

vRealize Automation

vRealize Log Insight

vRealize Operations Manager

Virtual Storage Area Network

Virtual Storage Integrator

(Intel) Virtualization Technology

VMware Validated Design
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All significant technical terms used within this document are defined in other key documents,
particularly National Institute of Standards and Technology Interagency Report (NISTIR) 7904, Trusted
Geolocation in the Cloud: Proof of Concept Implementation. As a convenience to the reader, terms
critical to understanding this volume are provided in this glossary.

Cloud workload

Geolocation

Hardware root of
trust

Trusted compute
pool

A logical bundle of software and data that is present in, and processed by, a
cloud computing technology.

Determining the approximate physical location of an object, such as a cloud
computing server.

An inherently trusted combination of hardware and firmware that maintains
the integrity of information.

A physical or logical grouping of computing hardware in a data center that is
tagged with specific and varying security policies. Within a trusted compute
pool, the access and execution of applications and workloads are monitored,
controlled, audited, etc. Also known as a trusted pool.
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